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LIMITED WARRANTY

 

Opcode Systems, Inc. warrants the 
Studio 64 XTC against defects in materials and 
workmanship for a period of one (1) year from 
the date of original retail purchase.

If you discover a defect, first write or call 
Opcode Systems, Inc. at (650) 856-3333 to 
obtain a Return Merchandise Authorization 
Number (no service will be performed on any 
product returned without prior authorization). 
If the product needs to be returned to Opcode, 
please attach your name, address, telephone 
number, a description of the problem, and a 
copy of the dated bill of sale as proof of pur-
chase. Write the Return Merchandise 
Authorization (RMA) Number clearly on the 
outside of the package and all correspondence. 
Upon receiving the returned product, Opcode 
Systems, Inc. will then, at its option, repair, 
replace, or refund the purchase price of the 
product.

This warranty applies only to the 
Studio 64 XTC; Opcode software is warranted 
separately.

This warranty does not apply if the product has 
been damaged by accident, abuse, misuse, or 
misapplication, or has been modified without 
the written permission of Opcode Systems, 
Inc.

All implied warranties, including implied war-
ranties of merchantability and fitness for a 
particular purpose, are limited in duration to 
one (1) year from the original date of retail pur-
chase of this product. The warranty and 
remedies set forth above are exclusive and in 
lieu of all others, oral or written, express or 
implied.

Opcode Systems, Inc. is not responsible for 
special, incidental, or consequential damages 
resulting from any breach of warranty, or 
under any legal theory, including lost profits, 
downtime, good-will, damage to or replace-
ment of equipment and property.

Some states do not allow the exclusion or limi-
tation of implied warranties or liability for 
incidental or consequential damages, so the 
above limitation or exclusion may not apply to 
you. This warranty gives you specific legal 
rights, and you may also have other rights 
which vary from state to state.

Except to the extent prohibited by law, all 
implied warranties made by Opcode Systems, 
Inc. in connection with this manual and soft-
ware are limited in duration to ninety (90) days 
from the date of original purchase, and no war-
ranties, whether express or implied, shall 
apply to this product after said period.

Opcode Systems, Inc. makes no warranty or 
representation, either express or implied, with 
respect to the software described in this man-
ual. This software is sold “as is.” The 
purchaser assumes the entire risk as to its 
quality and performance. Under no circum-
stances shall Opcode Systems, Inc. be liable 
for any loss or damage, direct, consequential, 
or incidental, arising out of the use or inability 
to use this product.

Some states do not allow limitations on how 
long an implied warranty lasts or the exclusion 
or limitation of incidental or consequential 
damages, so the above limitations or exclu-
sions may not apply to you.



 

TRADEMARKS

 

Studio 64 XTC is a trademark of Opcode Systems, Inc. IBM 
is a registered trademark of International Business 
Machines Corporation. Windows is a trademark of 
Microsoft Corporation. Macintosh is a trademark of Apple 
Computer, Inc. Other product and brand names are trade-
marks or registered trademarks of their respective 
companies.

 

RADIO FREQUENCY INTERFERENCE

 

This equipment has been tested and found to comply with 
the limits for a Class B digital device, pursuant to Part 15 of 
the FCC Rules.

These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. 
This equipment generates, uses, and can radiate radio fre-
quency energy and, if not installed and used in accordance 
with the instructions, may cause harmful interference to 
radio communications. However, there is no guarantee that 
interference will not occur in a particular installation. If this 
equipment does cause harmful interference to radio or tele-
vision reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try to cor-
rect the interference by one or more of the following 
measures:

• Reorient or relocate the receiving antenna of the 
affected radio or television.

• Increase the separation between the equipment and 
the affected receiver.

• Connect the equipment and the affected receiver to 
power outlets on separate circuits.

• Consult the dealer or an experienced radio/TV techni-
cian for help.

 

Modifications

 

: Changes or modifications not expressly 
approved by Opcode Systems, Inc. could void the user’s 
authority to operate the equipment, per FCC regulations.

 

Shielded Cables

 

: Shielded cables must be used with this 
equipment to maintain compliance with FCC regulations.

 

Declaration of Conformity

We, Opcode Systems, Inc.,
3950 Fabian Way, Suite 100

Palo Alto, CA 94303 USA
(650) 856-3333

declare under our sole responsibility that the product

Opcode Studio 64 XTC

complies with Part 15 of FCC Rules. Operation is subject to 
the following two conditions: (1) this device may not cause 
harmful interference, and (2) this device must accept any 
interference received, including interference that may cause 
undesired operation.

 

CSA RADIO FREQUENCY INTERFERENCE

 

This Class B digital apparatus meets all the requirements of 
the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe B respecte toutes les 
exigences du Règlement sur le matériel brouilleur du 
Canada.

Declaration Of Conformity

We, Opcode Systems, Inc., of
3950 Fabian Way, Suite 100

Palo Alto, CA 94303 USA
declare under our sole responsibility that the product

Studio 64 XTC, a MIDI interface
for Macintosh and IBM PC compatible computers,

to which this declaration relates is in conformance with the 
following

standards:
EN55022:1987

EN50082-1:1992
IEC 801-2:1984
IEC 801-3:1984
IEC 801-4:1988

following the provisions of the 89/336/EEC Directive.



 

ACKNOWLEDGMENTS

 

Hardware Design and Studio 64 XTC firmware 
by David Rowe.

OMS, Studio Patches Editor, and 
Studio 64 XTC OMS driver by Doug Wyatt.

Patchbay and Studio 64 XTC Windows driver 
by Paul Messick, Jarrell Irvin, and 
Aron Nelson.

Quality Assurance by Mark LeBlanc.

Documentation by Greg Thomas.

Product Management by Randy Wilson.



 

Studio 64 XTC Manual 

 

v

 

TABLE OF CONTENTS

 

PART 1: Overview and Installation  1

 

CHAPTER 1: Introduction 3

 

About the Studio 64 XTC ..................................................................... 3
System Requirements................................................................... 3
What’s Included............................................................................. 4

How to Use this Manual ...................................................................... 4
Customer Support and Registration ................................................... 5

 

CHAPTER 2: Panel Descriptions 7

 

Front Panel............................................................................................ 7
Rear Panel ............................................................................................. 9
Dual Computer Connection .............................................................. 11

 

CHAPTER 3: IBM PC Configuration 13

 

IBM PC Configuration ....................................................................... 13
Connect Hardware ...................................................................... 13

Serial Port Considerations (PC) ......................................... 14
Run the Setup Program .............................................................. 14

Using Windows Software................................................................... 15

 

CHAPTER 4: Macintosh Configuration 17

 

Macintosh Configuration................................................................... 17
Connect Hardware ...................................................................... 17

Serial Port Considerations (Mac)....................................... 18
Install and Configure OMS ........................................................ 18

Studio 64 XTC as a Second Interface ............................................... 19
Using Macintosh MIDI Software...................................................... 19



 

Table of Contents

 

vi

 

Opcode Systems, Inc.

 

CHAPTER 5: MIDI Instrument Connections 21

 

MIDI Instrument Connections ......................................................... 21
Receiving MIDI from your Instruments ................................... 21
Sending MIDI to your Instruments........................................... 22

When to Connect both Ports .............................................. 22
Sharing Ports........................................................................ 22

MIDI Routing, Merging and Processing ......................................... 23
Audio Connections ............................................................................. 23

 

CHAPTER 6: A Test Run 25

 

Verifying MIDI Connections............................................................. 25
Verifying PC Connections with XTCDIAG...................................... 26
Verifying Mac Connections with Test Studio.................................. 26

 

PART 2: Studio 64 XTC Programs  27

 

CHAPTER 7: Studio 64 XTC Programs 29

 

User Programs ................................................................................... 29
Default Factory User Programs........................................................ 30

Default Sync Settings.................................................................. 31
Preset Programs................................................................................. 31
Front Panel Operations...................................................................... 31

 

CHAPTER 8: Editing User Programs under Windows 33

 

Using the Program Editor ................................................................. 33
Program Sets ............................................................................... 33

Program Edit Window (PC).............................................................. 34
SMPTE Window.......................................................................... 36

Program Editor Menu Reference ..................................................... 36



 

Table of Contents

Studio 64 XTC Manual 

 

vii

 

CHAPTER 9: Editing User Programs on the Macintosh 39

 

Using OMS Setup................................................................................39
Program Sets ................................................................................39

Program Edit Window (Mac) ............................................................40
SMPTE Window...........................................................................42

Studio 64XTC Menu............................................................................42

 

PART 3: Synchronization  45

 

CHAPTER 10: Synchronization Basics 47

 

About SMPTE......................................................................................47
Time Base and Address......................................................................49

Blackburst and Video Signals.....................................................49
Sync Reference Modes .......................................................................50
Word Clock and Super Clock ............................................................51

Sample Rate ..................................................................................51
Pull Up/Down Setting .................................................................52

Lock-up Time.......................................................................................52
Digital Phase Lock.......................................................................53

 

CHAPTER 11: Working with SMPTE and MTC 55

 

Studio 64 XTC and SMPTE................................................................55
How the Studio 64 XTC Stripes SMPTE ...................................55
How the Studio 64 XTC Reads SMPTE.....................................55
SMPTE Freewheel.......................................................................56
Jam Sync .......................................................................................56

SMPTE Connections ..........................................................................56
Striping/Syncing to Tape under Windows.......................................58
Striping/Syncing to Tape on the Macintosh....................................59
Generating SMPTE.............................................................................61
MIDI Time Code .................................................................................61

Generating MTC..........................................................................61



 

Table of Contents

 

viii

 

Opcode Systems, Inc.

 

CHAPTER 12: ADATs and other MMC Devices 63

 

About MIDI Machine Control........................................................... 63
Working with Alesis ADATs ............................................................. 63

ADAT ID and Offset.................................................................... 64
MMC Setup for ADATs .............................................................. 65
Taking the ADAT Offline ........................................................... 66

Controlling other MMC Devices ...................................................... 67
Using a Tascam DA-88 ............................................................... 67

 

CHAPTER 13: Word/Super Clock, Blackburst and Video Sync 69

 

Using Word Clock and Super Clock ................................................ 69
Analog Multitrack and Pro Tools .............................................. 69
Session 8 PC and DA-88 ............................................................. 70

Using Blackburst/Video Sync .......................................................... 71
Video Deck and Pro Tools ......................................................... 71
Blackburst, Video Deck, and DA-88.......................................... 72
Blackburst, Video Deck, Pro Tools, and ADAT....................... 73

 

PART 4: Appendices  75

 

APPENDIX A: Troubleshooting 77

APPENDIX B: Networking 83

APPENDIX C: Windows Drivers 85

APPENDIX D: PC Serial Ports 91

APPENDIX E: OMS Studio Patches for Macintosh 95



 

Studio 64 XTC Manual

 

1

 

PART 1: Overview and Installation



 

PART 1: Overview and Installation

 

2

 

Opcode Systems, Inc.



 

Studio 64 XTC Manual

 

3

 

CHAPTER 1: Introduction

 

ABOUT THE STUDIO 64 XTC

 

Thank you for purchasing Opcode’s 
Studio 64 XTC, a dual platform MIDI 
interface, patchbay, and digital sync pro-
cessor. The Studio 64 XTC includes the 
following capabilities:

• Compatible with notebook, laptop, 
and desktop Macs and PCs;

• Reads, stripes, and generates all 
SMPTE formats, also includes free-
wheeling and regeneration;

• ADAT Sync port for MMC control of 
one or more Alesis ADATs;

• Word Clock sync out for digital tape 
recorders and hard disk recorders;

• Super Clock sync out for Digidesign 
digital audio hardware;

• Accepts sync input from Blackburst 
(house sync) or composite video;

• 4 x 6 MIDI interface with support for 
64 channels;

• Stand-alone MIDI patchbay—recall 
routings and filterings, or even stripe 
SMPTE from front panel;

• 4 user programs accessible from front 
panel for MIDI routing and filtering; 

• 4 preset programs accessible from 
front panel: PANIC, SMPTE, ALL, 
and TUNE;

• Front panel status LEDs for SMPTE 
and sync status, and MIDI IN/OUT 
activity;

• MME compatible driver for 
Windows 3.1, Windows 95, and Win-
dows for Workgroups;

• OMS driver for Macintosh, including 
support for OMS Studio Patches.

 

System Requirements

 

To use the Studio 64 XTC with a PC, 
you need:

• An IBM PC compatible with 
16550 COM port;

• Windows 3.1, Windows for Work-
groups, or Windows 95;

• MIDI instruments and cables.

To use the Studio 64 XTC with a 
Macintosh, you need:

• A 68020 Macintosh or faster, or a 
Power Macintosh;

• System 7.0.1 or later;
• 4 MB of available RAM;
• MIDI instruments and cables.
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What’s Included

 

Your Opcode Studio 64 XTC package 
includes:

• Studio 64 XTC MIDI interface;
• DC power adapter;
• PC serial cable—a 10’ 9-pin DSub 

male to 9-pin DSub female cable, all 
pins wired straight through;

• PC cable adapter—a 9-pin male to 
25-pin female adapter for 25-pin serial 
port connectors;

• Macintosh serial cable—a 10’ 8-pin 
mini-DIN (RS-422) cable;

• PC floppy disk with Setup program 
that installs MME compatible Win-
dows driver, XTCDIAG diagnostics 
software, and Studio 64 XTC Program 
Editor;

• Macintosh floppy disks with OMS 
software and Studio Patches Manual 
(PDF version);

• Studio 64 XTC Reference Manual;
• OMS Manual for Mac users;
• Technical Support Information 

booklet;
• Registration card.

 

HOW TO USE THIS MANUAL

 

This manual does not attempt to teach 
fully the fundamentals of MIDI or syn-
chronization. If you’re new to either of 
these topics, you should read magazines 
specializing in music technology, or pur-
chase basic MIDI and SMPTE books 
from your local bookstore or music 
dealer.

If using a Macintosh, you should be famil-
iar with the basic operations of the 
Mac OS; or if you’re using a PC, you 
should have a general grasp of using the 
Windows operating system.

This manual discusses how to connect, 
configure, and use the Studio 64 XTC—it 
describes Studio 64 XTC operations at the 
time of its printing. However, updates and 
changes may occur. Always look for hard-
ware and software update information in 
the Read Me files installed onto your hard 
disk.

This manual is divided into four parts:

•

 

Part 1: Overview and Installation

 

(Chapters 1-6)—These chapters dis-
cuss the Studio 64 XTC’s front and 
rear panels, configuration for both PC 
and Macintosh, MIDI instrument con-
nections, and a quick test run of the 
unit.

•

 

Part 2: Studio 64 XTC Programs

 

(Chapters 7-9)—These chapters dis-
cuss the Studio 64 XTC’s user and 
preset programs, how they are 
selected, initialized, edited, and 
stored.
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•

 

Part 3: Synchronization

 

(Chapters 10-13)—These chapters 
provide a guide to using the synchro-
nization capabilities of the 
Studio 64 XTC, which include 
SMPTE, MIDI Machine Control, 
Word Clock and Super Clock sync, 
and Blackburst and video sync.

•

 

Part 4: Appendices

 

The appendices cover Studio 64 XTC 
troubleshooting, networking, install-
ing/removing Windows drivers, 
checking for PC serial devices, and 
OMS Studio Patches for Mac.

 

OMS and Studio Patches Manuals (Mac)

 

Macintosh users must install and config-
ure the Open Music System (OMS) to use 
the Studio 64 XTC.

Included with your Studio 64 XTC pack-
age is a printed OMS Manual and an 
online (PDF) version of the 
Studio Patches Manual. Please read these 
manuals to take full advantage of the 
Studio 64 XTC’s Mac capabilities.

For a brief explanation of OMS Studio 
Patches, see 

 

Appendix E: OMS Studio 
Patches for Macintosh

 

.

 

CUSTOMER SUPPORT AND 
REGISTRATION

 

Registering your Studio 64 XTC

 

Please complete and return your registra-
tion card right away. Doing so will enable 
Opcode to deliver the best possible sup-
port to you; it also ensures you’ll receive 
important update/upgrade notices.

 

IMPORTANT: Please write down your 
Studio 64 XTC serial number here. The 
serial number is on the bottom of the 
Studio 64 XTC.

 

S/N _______________________________

Purchase Date ______________________

 

Contacting Opcode

 

Opcode provides a variety of phone, fax, 
and online support options. Consult your 

 

Technical Support Information

 

 booklet on 
how best to contact Opcode.

 

Figure 1.1: 
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CHAPTER 2: Panel Descriptions

 

FRONT PANEL

 

Figure 2.1: Studio 64 XTC Front Panel

 

Following is a description of the front 
panel components of the Studio 64 XTC:

 

Program Button

 

The PROGRAM button selects the cur-
rent program or sync function. Press the 
button once and an LED flashes rapidly to 
indicate the currently selected program. 
Press the PROGRAM button repeatedly 
to advance to and select a particular pro-
gram or sync function.

 

MIDI Input LEDs

 

The red input LEDs flash when MIDI data 
is received by the Studio 64 XTC. The 
input LEDs also indicate when a user pro-
gram is selected.

 

MIDI Output LEDs

 

The green output LEDs flash when MIDI 
data is transmitted by the Studio 64 XTC. 
The output LEDs also indicate when a 
preset program is selected.

 

Sync Function LEDs

 

The red Sync Function LEDs indicate 
when one of the three sync functions is 
selected (by the PROGRAM button). 
Unlike the LEDs for MIDI input/output, 
the LED for the currently selected sync 
function is always lit.

The sync functions include Sample Rate, 
Sync Ref, and SMPTE. See 

 

Sync Status 
LEDs (pg. 8)

 

 for an explanation of the dif-
ferent sync function options.

 

Sync Button

 

The SYNC button is used to edit settings 
for the three sync functions: Sample Rate, 
Sync Ref, and SMPTE.

Once a sync function is selected with the 
PROGRAM button, press the SYNC 
button to step through and choose from 
the various sync options.
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Sync Status LEDs

 

The green Sync Status LEDs provide a 
means for monitoring and editing sync 
settings. Following is a description of the 
options for each sync function.

 

Sample Rate Function

 

When the sync function is 

 

Sample Rate

 

, 
the sync status LEDs indicate the sample 
rate of the Word Clock and Super Clock 
generated by the Studio 64 XTC; whether 

 

Pull Up

 

 or 

 

Pull Down

 

 is used; and if an 
Alesis ADAT is connected and online.

The sync status LEDs are lit steadily 
when a sample rate or Pull Up/Down 
mode is selected. Use the SYNC button to 
step through any of the following combi-
nation settings: 44.1, 44.1/P-UP, 44.1/
P-DN, 48, 48/P-UP, or 48/P-DN.

For more information on Word Clock, 
Super Clock, and Pull/Up Down, see 

 

Word Clock and Super Clock (pg. 51)

 

.

The ADAT status LED is lit when an 
ADAT (turned on) is detected by the 
Studio 64 XTC’s ADAT Sync port. To take 
the ADAT offline, press the SYNC button 
repeatedly until the ADAT LED is 
selected—as a result, the LED will blink 
slowly, indicating the ADAT is offline. For 
more details, see 

 

Taking the ADAT Offline 
(pg. 66)

 

.

If the ADAT is not turned on, or correctly 
connected to the Studio 64 XTC, the 
ADAT status LED will not be lit.

 

Sync Ref Function

 

When the sync function is 

 

Sync Ref

 

, one 
or two of the sync status LEDs is lit 
steadily to indicate the Studio 64 XTC’s 
referenced sync sources for 

 

address

 

 (play-
back location) and 

 

time base

 

 (playback 
speed).

For a detailed explanation of how the 
Studio 64 XTC works with address and 
time base sources, see 

 

Time Base and 
Address (pg. 49)

 

 and 

 

Sync Reference Modes 
(pg. 50)

 

.

Following are the available choices for 
sync source references:

•

 

Internal

 

: Studio 64 XTC generates an 
internal timing source.

•

 

SMPTE

 

: SMPTE time code from the 
SMPTE IN jack is referenced.

•

 

MTC

 

: MIDI Time Code received 
from one of the four MIDI inputs, or 
from a computer program, is 
referenced.

•

 

Video

 

: Blackburst or composite video 
signal received from the Blackburst/
Video IN port is referenced.

Use the SYNC button to step through the 
following Sync Ref combination settings: 
Int, Int/Video, SMPTE, SMPTE/Video, 
MTC, MTC/Video.

If the Sync Reference mode is set to 
receive Video, the Video LED is lit con-
stantly when receiving the composite or 
Blackburst signal. When these signals are 
not present, the Video LED blinks slowly.
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SMPTE Function

 

When the sync function is 

 

SMPTE

 

, the 
sync status LEDs indicate the frame rate 
of received and transmitted SMPTE (or 
MTC). The LED flashes rapidly when 
receiving time code and slowly when gen-
erating time code.

Use the SYNC button to override the 
SMPTE format of the current user 
program.

Supported frame rates include:

• 30 Frames/second (Non-Drop)
• 29.97 Frames/second (Non-Drop)
• 29.97 Drop Frame
• 25 Frames/second
• 24 Frames/second

For an explanation of the different 
SMPTE formats and related terminology, 
see 

 

About SMPTE (pg. 47)

 

.

 

NOTE: When receiving 29.97ND, the 
Studio 64 XTC always detects it as 30ND. 
It is not possible for hardware or software to 
tell the difference between these two SMPTE 
formats.

 

On LED

 

The yellow On LED glows steadily when 
the Studio 64 XTC is powered on.

 

Power On/Off Switch

 

The POWER switch turns on/off the 
Studio 64 XTC. When powering up, all 
LEDs flash simultaneously four times. 
Make sure power is off before making any 
connections.

 

REAR PANEL

 

Figure 2.2: Studio 64 XTC Rear Panel

 

Following is a description of the rear 
panel connectors of the Studio 64 XTC:

 

9V DC 300MA

 

The provided DC adapter supplies power 
to the Studio 64 XTC via this jack.

The type of power supply included 
depends on where you purchase your 
Studio 64 XTC:

• U.S. and Canada: 7.5cDC - 9vDC, 
300mA, 5.5mm x 2.1mm center posi-
tive barrel plug.

• Europe: 7.5cDC, 300mA, 5.5mm x 
2.1mm center positive barrel plug.

 

SMPTE Out

 

The Studio 64 XTC sends SMPTE via this 
1/4” unbalanced phone jack when strip-
ing or generating sync.
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To facilitate setting levels, the 
Studio 64 XTC emits a constant leader 
tone when not striping or generating 
SMPTE.

 

SMPTE In

 

The Studio 64 XTC receives SMPTE via 
this 1/4” unbalanced phone jack.

An optimum SMPTE signal has a level 
between -10 db and -3 db, and should not 
be processed by equalization, compres-
sion/limiting, or noise reduction.

 

Word Clock Out

Word Clock is transmitted via this BNC 
connector to digital tape recorders and 
hard disk recorders—thereby providing 
frame accurate digital audio 
synchronization.

Expansion

The Expansion port provides for possible, 
future hardware options that will expand 
the capabilities of the Studio 64 XTC.

ADAT Sync

The Studio 64 XTC uses this port to con-
nect to the “Sync In” port of an 
Alesis ADAT. Once connected, the 
Studio 64 XTC provides MMC control 
over the connected ADAT, and any addi-
tional daisy-chained ADATs.

To connect to the ADAT, use a standard 
PC serial cable like the one included with 
your Studio 64 XTC package (a 9-pin 
DSub male to 9-pin DSub female cable, all 
pins wired straight through).

Network

This RS-422 serial port lets the 
Studio 64 XTC network to an Opcode 
Studio 4, thereby allowing both interfaces 
to share the same computer port.

For information on using the 
Studio 64 XTC’s Network port, see 
Appendix B: Networking.

Mac

This RS-422 serial port connects to your 
Macintosh computer with the provided 
(Mac) serial cable.

The included Mac cable is a 10’ 8-pin mini-
DIN (AppleTalk) cable, commonly used 
to connect printers and modems.

PC

This 9-pin serial port connects to your 
IBM PC 16550 COM port with the pro-
vided (PC) serial cable.

The included PC cable is a 10’ 9-pin DSub 
male to 9-pin DSub female cable, all pins 
wired straight through.

NOTE: If your COM port has a 25-pin con-
nector, use the provided PC cable adapter 
(a 9-pin male to 25-pin female adapter).
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Super Clock Out

Digidesign’s proprietary Super Clock 
signal is transmitted via this BNC connec-
tor (connects to the “Slave Clock” input of 
Digidesign audio interfaces). This pro-
vides an extremely accurate means of 
digital audio synchronization.

Blackburst/Video In

The Studio 64 XTC receives Blackburst 
(house sync) or composite video via this 
BNC connector.

MIDI Outputs

The Studio 64 XTC transmits MIDI to any 
of four MIDI outputs. Each output port 
(identified by number, 1 - 4) represents a 
discrete set of 16 MIDI channels.

Two MIDI outputs (A and B) are provided 
for ports 1 and 2. Therefore, devices shar-
ing ports 1A and 1B, for instance, receive 
the same MIDI information.

MIDI Inputs

The Studio 64 XTC receives MIDI from 
any of four MIDI inputs. Each input port 
(identified by number, 1 - 4) represents a 
discrete set of 16 MIDI channels.

DUAL COMPUTER 
CONNECTION

The Studio 64 XTC can be connected to 
either an IBM PC or Macintosh. What’s 
more, the interface can even be con-
nected to both types of computers at the 
same time.

However, when connecting to both a Mac 
and PC, the Studio 64 XTC can communi-
cate with only one computer at a time. 
Don’t worry though, the Studio 64 XTC’s 
auto-sensing capability always knows 
which computer to respond to.
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CHAPTER 3: IBM PC Configuration

IBM PC CONFIGURATION

Connect Hardware

IMPORTANT: If you have other serial 
devices (such as a mouse or modem) con-
nected to a COM port on your PC, please 
see Appendix D: PC Serial Ports on 
page 91 before proceeding.

To connect the Studio 64 XTC to your PC:

a Turn off your computer, peripherals, 
and MIDI instruments.

b Plug one end of the provided serial 
cable into the PC port of your 
Studio 64 XTC; plug the other end of 
the serial cable into your computer’s 
COM port. 

Make note of whether you are connect-
ing to COM1 or COM2.

If your COM port has a 25-pin connector, 
use the provided PC cable adapter.

c Using standard MIDI cables, connect 
the MIDI OUTs of your instruments to 
the MIDI INs of the Studio 64 XTC; 
then connect the MIDI INs of your 
instruments to the MIDI OUTs of the 
Studio 64 XTC.

For more details, see Chapter 5: MIDI 
Instrument Connections.
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d Plug the small end of the provided 
power adapter into the 
Studio 64 XTC’s 9VDC 300MA jack; 
plug the other end into an AC power 
source.

Make sure your power adapter is set to 
or compatible with the AC voltage in your 
area.

e Turn on your computer, peripherals, 
Studio 64 XTC, and MIDI 
instruments—in that order. 

For best results, use a power strip to turn 
on/off all equipment simultaneously.

Serial Port Considerations (PC)

An IBM PC compatible may have up to 
four COM ports: COM1 - COM4. Separate 
COM ports can share the same IRQ, but 
they cannot operate at the same time. 
Generally, COM1 and COM3 are 
assigned to IRQ4, while COM2 and 
COM4 are assigned to IRQ3.

If your COM port has a 9-pin connector, 
use the provided PC serial cable to con-
nect to the Studio 64 XTC.

If your COM port uses a 25-pin connector, 
plug the provided PC cable adapter 
between your computer and the provided 
PC serial cable, which plugs into the 
Studio 64 XTC.

Run the Setup Program

To install the necessary PC software for 
the Studio 64 XTC:

a Insert the PC disk and double-click 
the Setup program.

b When prompted, specify which 
Studio 64 XTC software components 
you wish to install and click Next.

First-time installers should install all 
components.

c Specify an install directory and then 
click  Next.

d When prompted, specify which COM 
port and IRQ you are using for the 
Studio 64 XTC connection.

Generally, COM1 and COM3 default to 
IRQ4, while COM2 and COM4 default to 
IRQ3.

e Once you’ve specified the COM port 
settings, click Next to install all 
necessary software.

Files copied to your hard disk include the 
Studio 64 XTC driver files, XTCDIAG 
(diagnostics software), and 64xtc.exe  
(Studio 64 XTC Program Editor).

Additionally, the necessary changes are 
made to your System.ini file. A backup of 
your original System.ini file (renamed to 
“system.xtc”) is stored in your Windows 
directory.

f When prompted, restart Windows for 
changes to take effect.
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USING WINDOWS SOFTWARE

Once you’ve installed the Studio 64 XTC 
driver, the following ports are available in 
Windows MIDI applications:

• 64XTC In1 - In4: Receives MIDI 
from the specified input ports.

• 64XTC Sync Port: Receives MIDI 
Time Code, corresponding to 
received or generated SMPTE; also 
receives responses to sysex mes-
sages sent to it via the Control Port.

• 64XTC ADAT In Port: Receives 
timing and location information from 
the ADAT connected to the 
Studio 64 XTC’s ADAT Sync port.

• 64XTC Out1 - Out4: Sends MIDI to 
the specified output ports.

• 64XTC Broadcast Port: Sends 
MIDI to all output ports 
simultaneously.

• 64XTC ADAT Out Port: Sends 
MMC commands to the ADAT con-
nected to the Studio 64 XTC’s ADAT 
Sync port.

• 64XTC Control Port: Sends system 
exclusive messages to the 
Studio 64 XTC governing its opera-
tion. Most users will not use this port 
and should not select it.

It’s important to grasp that these various 
input/output options designate how MIDI 
is communicated between the 
Studio 64 XTC and Windows applications.

When recording performance data, make 
sure you enable the In port to which your 
main keyboard controller is attached. 
When assigning MIDI tracks for play-

back, specify the correct Out port for the 
desired instrument. And if you intend to 
sync to SMPTE, you should select the 
Sync Port.

NOTE: If you are ever unsure of where 
MIDI is being sent or from where it is being 
received (or if you are receiving SMPTE 
time code), just look at the LEDs on the 
front panel of the Studio 64 XTC.

For details on selecting and assigning 
MIDI ports in Windows applications, con-
sult your software manuals.

OMS Applications under Windows

When using OMS applications under 
Windows, such as Vision 2.5.1, device 
names from the current Studio Setup are 
used instead of Windows MIDI port 
names.

For instance, when creating a new Studio 
Setup in OMS, the Studio 64 XTC appears 
with seven ports, each with an attached 
device (see Figure 3.1).

Figure 3.1: OMS Studio Setup containing a 
Studio 64 XTC under Windows
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These devices (shown in Figure 3.1) 
directly correspond to the MIDI ports 
appearing in other (non-OMS) Windows 
applications.

• Ports 1-4: MIDI in/out ports 1-4
• Port 5: ADAT in/out port
• Port 6: Sync in/control out port
• Port 7: Broadcast out port

Depending on your needs, these OMS 
devices can be renamed or deleted as 
desired. Consult your OMS Manual for 
details.
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CHAPTER 4: Macintosh Configuration

MACINTOSH CONFIGURATION

Connect Hardware

To connect the Studio 64 XTC to your 
Macintosh:

a Turn off your computer, peripherals, 
and MIDI instruments.

b Plug one end of the provided serial 
cable into the MAC port of your 
Studio 64 XTC; plug the other end of 
the serial cable into your computer’s 
modem or printer port.

c Using standard MIDI cables, connect 
the MIDI OUTs of your instruments to 
the MIDI INs of the Studio 64 XTC; 
then connect the MIDI INs of your 

instruments to the MIDI OUTs of the 
Studio 64 XTC. 

For more details, see Chapter 5: MIDI 
Instrument Connections.

d Plug the small end of the provided 
power adapter into the 
Studio 64 XTC’s 9VDC 300MA jack; 
plug the other end into an AC power 
source.

Make sure your power adapter is set to 
or compatible with the AC voltage in your 
area.

e Turn on your computer, peripherals, 
Studio 64 XTC, and MIDI 
instruments—in that order. 

For best results, use a power strip to turn 
on/off all equipment simultaneously.
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Serial Port Considerations (Mac)

Either of the Mac’s two serial ports, 
modem or printer, may be connected to 
the Studio 64 XTC. When configuring 
OMS for the first time, you must specify 
which port (modem or printer) you are 
using. If a particular port is unavailable for 
MIDI, OMS will inform you.

A port may be unavailable for MIDI if you 
are using AppleTalk, fax/modem soft-
ware, or other MIDI management 
software. For more details, consult your 
OMS Manual.

Install and Configure OMS

To install and configure OMS:

a Insert the provided OMS disk 1 and 
double-click Install OMS.

At the initial prompt, specify you are 
using a Studio 64 XTC.

b When reaching the main install 
screen, choose the “Easy Install” 
option and then click the Install 
button.

c Insert each disk as prompted.

d When completed, exit the installer and 
restart your Macintosh.

e After restarting, launch the 
OMS Setup application and 
configure a “New Studio Setup.” 

Consult your OMS Manual for help with 
Studio Setup configuration.

About OMS

To use the Studio 64 XTC with a Macin-
tosh you must install and configure the 
Open Music System (OMS). OMS keeps 
track of how your MIDI studio is con-
nected and configured and stores this 
information in Studio Setup documents. 
Studio Setups are created and edited in 
the OMS Setup program.

If turned on and connected properly, the 
Studio 64 XTC is automatically detected 
by OMS when configuring a new Studio 
Setup. Once OMS knows that you’re 
using a Studio 64 XTC, a Studio 64XTC 
menu appears in the OMS Setup 
application. Use this menu to store and 
retrieve user programs, open the Pro-
gram Edit and SMPTE Windows, and 
check the unit’s ROM version.

OMS Studio Patches

OMS Studio Patches provide advanced 
MIDI processing capabilities for the 
Studio 64 XTC (implemented on the Mac-
intosh only).

For a short summary of Studio Patches, 
see Appendix E: OMS Studio Patches for 
Macintosh. For a complete and thorough 
explanation, consult the PDF version of 
the Studio Patches Manual included with 
your Studio 64 XTC package.
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STUDIO 64 XTC AS A SECOND 
INTERFACE

If you have an existing MIDI interface, 
you can use the Studio 64 XTC as a 
second interface. Simply connect one 
interface to the modem port and the other 
to the printer port. Then when configur-
ing OMS, make sure to enable both ports 
before searching for interfaces.

For information on connecting additional 
MIDI interfaces to the Network port of 
the Studio 64 XTC, see 
Appendix B: Networking.

USING MACINTOSH MIDI 
SOFTWARE

OMS-Compatible Applications

Once you have configured an OMS 
Studio Setup, using OMS-compatible 
applications is quite seamless. Any 
devices contained in your Studio Setup 
document are automatically available in 
OMS applications, and you can even 
select them by name. If at some point you 
make changes in your current Studio 
Setup, OMS applications are updated.

If you wish to receive SMPTE time code 
in an OMS application, the Studio 64 XTC 
appears as a sync source.

If you are using Studio Patches and have 
created a Studio Patches document, any 
of its “virtual instruments” and “virtual 
controllers” are also accessible from OMS 
applications.

Non-OMS Applications

The Studio 64 XTC is compatible with 
non-OMS applications. When using such 
an application, the Studio 64 XTC acts like 
a standard MIDI interface—thereby pro-
viding only 16 MIDI channels. In 
“standard interface mode,” the 
Studio 64 XTC merges all MIDI inputs 
into the computer; additionally, all trans-
mitted MIDI is simultaneously sent to all 
four outputs.

IMPORTANT: To use non-OMS applica-
tions, the current Studio 64 XTC user 
program must route MIDI to and from the 
computer.
Figure 4.1: 
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CHAPTER 5: MIDI Instrument Connections

MIDI INSTRUMENT 
CONNECTIONS

The Studio 64 XTC is a multiport MIDI 
interface. This means that each of its four 
discrete input and output ports supports 
16 MIDI channels, providing a total of 64 
channels.

The Studio 64 XTC receives MIDI data 
from MIDI inputs 1 - 4, and sends data to 
MIDI outputs 1 - 4.

NOTE: Two MIDI outputs (A and B) are 
provided for ports 1 and 2. Therefore, 
devices connected to ports 1A and 1B, for 
instance, receive the same MIDI 
information.

Receiving MIDI from your 
Instruments

If you will receive MIDI data from any of 
your instruments, connect their MIDI 
OUTs to the MIDI INs of the 
Studio 64 XTC.

Figure 5.1: Instruments sending MIDI data

Types of devices from which you will want 
to receive MIDI include:

• Master keyboard controllers sending 
performance data;

• Devices sending timing information 
like external sequencers, drum 
machines, sync boxes, and MMC 
compatible recorders;

• Instruments transmitting system 
exclusive data for storage purposes.

Studio 64 XTC

Drum Machine

MIDI Controller

MIDI Out

MIDI Out

MIDI In
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Sending MIDI to your Instruments

If you will send MIDI data to any of your 
instruments, connect their MIDI INs to 
the MIDI OUTs of the Studio 64 XTC.

Figure 5.2: Instruments receiving MIDI data

Types of devices to which you will want to 
send MIDI include: 

• Instruments that will play back in 
sequences and arrangements;

• Devices that receive timing informa-
tion like external sequencers, drum 
machines, sync boxes, and MMC 
compatible recorders;

• Instruments retrieving system exclu-
sive data for restoring patches or 
configuration settings.

When to Connect both Ports

When you need to send and receive MIDI 
from an instrument, connect both of its 
MIDI jacks (OUT and IN) to the 
Studio 64 XTC. And if both ports of a 
MIDI instrument are connected, always 
use the same port number.

A common scenario necessitating this 
two-way communication is when using 
editor/librarian software.

IMPORTANT: When connecting both 
MIDI ports of an instrument, always use 
the same Studio 64 XTC port number.

Sharing Ports

If you have more than four instruments 
that will receive MIDI data, two MIDI out-
puts are provided for ports 1 (1A and 1B) 
and 2 (2A and 2B).

Figure 5.3: Two instruments sharing the same port 
(1A and 1B), assigned to different MIDI channels

Keep in mind that when instruments 
share a single port, they receive identical 
MIDI information. In these instances, the 
16 MIDI channels must be shared 
between the connected instruments; 
therefore, make sure these instruments 
are assigned to different MIDI channels.

Studio 64 XTC

MIDI Outs

MIDI In

MIDI In

MIDI In

Studio 64 XTC

Device 1, channels 1-8

Device 2, channels 9-16
MIDI In

MIDI In

MIDI Outs
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If you happen to have more than 6 devices 
that must receive MIDI, you can use the 
THRU port of an instrument to daisy-
chain additional instruments.

Figure 5.4: Two instruments sharing the same port 
(via THRU), assigned to different MIDI channels

Again, chained instruments sharing the 
same port receive identical MIDI informa-
tion and should therefore be assigned to 
different channels.

MIDI ROUTING, MERGING AND 
PROCESSING

In addition to functioning as a MIDI inter-
face and digital sync processor, the 
Studio 64 XTC can also act as a stand-
alone MIDI patchbay.

Customized user programs can be 
defined that include routings between any 
MIDI input and output; user programs 
can also store mutings for specific MIDI 
channels and/or messages. See 
Chapter 7: Studio 64 XTC Programs for 
details.

If you own a Macintosh, OMS Studio 
Patches provide even more advanced 
MIDI processing. For a brief explanation, 
see Appendix E: OMS Studio Patches for 
Macintosh.

AUDIO CONNECTIONS

The Studio 64 XTC is a MIDI interface 
and does not provide audio output. There-
fore, any MIDI instruments used for 
playback must have their audio outputs 
connected to an amplifier, mixer, speak-
ers or headphones. Consult your 
instrument manuals for information on 
audio connections.

Studio 64 XTC

Device 1, channels 1-8

Device 2, channels 9-16

MIDI In Thru

MIDI In
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CHAPTER 6: A Test Run

Once the Studio 64 XTC is connected to 
your MIDI instruments, you should check 
to see that it’s functioning properly.

NOTE: Before proceeding, make sure you 
do not have any MIDI feedback loops in 
your cabling. A MIDI loop occurs when 
data is erroneously routed back to its place 
of origin. MIDI loops can cause stuck notes, 
poor timing, or other unexpected behavior 
from MIDI instruments.

VERIFYING MIDI CONNECTIONS

a Turn on the Studio 64 XTC along with 
any connected MIDI instruments. 

When powered on, the On LED glows 
steadily.

b Press the PROGRAM button 
repeatedly until the ALL preset 
program is selected—once selected, 
its LED flashes.

c Play some notes on a MIDI controller 
connected to one of the MIDI INs of 
the Studio 64 XTC. 

As the notes are played, the correspond-
ing MIDI input LED flashes; additionally, 
all MIDI output LEDs flash since the ALL 
program routes MIDI data from any input 
to all outputs.

d Using the PROGRAM button, select 
the TUNE program—its LED flashes. 

All MIDI output LEDs flash as the 
Studio 64 XTC transmits continuous 
A440 note messages on all channels for 
each port. Any connected instruments 
play these notes.

e Press the PROGRAM button once to 
end the TUNE program. 

The previous program (ALL) is then 
reselected and its LED flashes.

f Press the PROGRAM button 
repeatedly to select and activate the 
SMPTE sync function. Then use the 
PROGRAM button to select the 
SMPTE preset program. 

The “30” sync status LED blinks slowly, 
indicating the Studio 64 XTC is generat-
ing SMPTE time code.

g Press the PROGRAM button once to 
exit from SMPTE striping.

h Next select the PANIC program. 

All MIDI output LEDs glow steadily for 
several seconds as note-off messages 
for all channels are sent to each port. 
Once completed, the Studio 64 XTC 
returns to the previous program. 

NOTE: You can interrupt either the TUNE 
or SMPTE programs by pressing the PRO-
GRAM button once, which automatically 
calls up the previously selected program.
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VERIFYING PC CONNECTIONS 
WITH XTCDIAG

Before attempting to use your Windows 
music software, you may wish to run 
XTCDIAG.EXE to verify the connection 
between the Studio 64 XTC and your PC. 
This DOS diagnostics program verifies 
your serial port connection and tests 
MIDI input and output.

NOTE: The Setup program on your PC 
floppy disk installs XTCDIAG into the spec-
ified hard disk location. For more details, 
see Chapter 3: IBM PC Configuration.

a Exit Windows and restart your 
computer in DOS mode.

b At the DOS prompt, type:

C:\64XTC\XTCDIAG

NOTE: This example uses the default 
install location for XTCDIAG. If you spec-
ified a different install directory or hard 
drive, please make the necessary 
change in this step.

c Then press the ENTER key.

The XTCDIAG program launches. 

d When prompted, specify your COM 
port and IRQ settings.

The XTCDIAG program tests the inter-
face connection. If the interface is not 
found, see Chapter D: PC Serial Ports 
for checking possible serial port 
conflicts.

e Once your connection is verified as 
valid, use the program’s Trace 
command to test MIDI input; and to 
test MIDI output, use the Scale 
command.

VERIFYING MAC 
CONNECTIONS WITH TEST 
STUDIO

An easy way to trouble-shoot MIDI com-
munication on the Macintosh is with 
Test Studio, which is enabled from the 
Studio menu in the OMS Setup 
application. 

Once Test Studio is enabled, click on any 
MIDI device in your Studio Setup docu-
ment to test MIDI output, or play some 
notes on your keyboard controller to 
verify MIDI input.

If Test Studio is unsuccessful, choose 
Studio>MIDI Cards & Interfaces to re-
establish communication with the 
Studio 64 XTC. Consult your OMS 
manual for more details on using 
Test Studio.
Figure 6.1: 
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CHAPTER 7: Studio 64 XTC Programs

USER PROGRAMS

The Studio 64 XTC has four user pro-
grams that specify how it processes MIDI 
input and output, and how it works with 
synchronization. User programs are 
stored in nonvolatile memory and recalled 
from the front panel with the PROGRAM 
button. When a user program is selected, 
its settings are always active—whether a 
MIDI software program is running, or 
even if the Studio 64 XTC is not con-
nected to a computer.

User programs are displayed and edited 
from the Program Edit Window, which 
can be accessed from the:

• Program Editor under Windows 
(see Chapter 8, page 33), 
or with the...

• OMS Setup application on the Mac 
(see Chapter 9, page 39).

IMPORTANT: If at any time you’d like to 
restore the default factory user programs, 
you can initialize the Studio 64 XTC. See 
Initializing User Programs (pg. 32).

Each Studio 64 XTC user program can 
control the following:

• MIDI Routing and Merging: Rout-
ings between any MIDI input and 
output are defined in the Connection 
Grid of the Program Edit Window. 
Each defined connection can have its 
own discrete settings for message 
and channel mutings.

• Message Filtering: MIDI messages 
can be filtered for each defined 
connection.

• Channel Filtering: MIDI channels 
can be filtered for each defined 
connection.

• Channel Shifting: For each defined 
connection, channel specification for 
MIDI messages can be shifted with 
the channel bump option.

• Sync Settings: Each user program 
stores settings for Sync Reference, 
Sample Rate and Pull Up/Down, Digi-
tal Phase Lock on/off, ADAT ID and 
offset, and SMPTE settings (frame 
rate, start time, freewheel, and MTC 
routing).
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DEFAULT FACTORY USER 
PROGRAMS

The four default user programs shipped 
with the Studio 64 XTC are configured 
with the following routings:

• Factory User Program 1
Inputs and outputs are routed to and 
from the computer only, which is an 
ideal configuration for MIDI 
sequencing.

Figure 7.1: Routing for User Program 1

• Factory User Program 2
Each input is routed to all outputs 
except for its corresponding output. 
For instance, IN1 > OUT2, OUT3, and 
OUT4.

Figure 7.2: Routing for User Program 2

• Factory User Program 3
Each input is routed only to its 
corresponding output. For instance, 
IN1 > OUT1, IN2 > OUT2, etc.

Figure 7.3: Routing for User Program 3

• Factory User Program 4
This default user program is identical 
to the ALL preset program, which 
routes all inputs to all outputs.

Figure 7.4: Routing for User Program 4

NOTE: Each of the default factory user pro-
grams routes the ADAT port to and from 
the computer, which is necessary for MMC 
control of connected ADATs.
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Default Sync Settings

In addition to the routings contained in 
each default user program, there are also 
default sync settings.

The default sync settings, identical for 
each of the four factory user programs, 
are as follows:

• Sync Reference Mode: Internal
• SMPTE Frame Rate: 30 Non-Drop
• SMPTE Start Time: 00:00:00:00
• Freewheel: 10 frames
• MTC Source: Computer
• Digital Phase Lock: On
• Sample Rate: 48 kHz
• ADAT Online: On
• ADAT ID: 0
• ADAT Offset: 00:00:00:00

PRESET PROGRAMS

In addition to the four user programs, the 
Studio 64 XTC also has four preset pro-
grams, which provide the following 
special functions:

• Preset Program 1: PANIC
When selected, an “all notes off” mes-
sage is sent to each of the four MIDI 
OUT ports to turn off stuck notes.

• Preset Program 2: SMPTE
When selected, the Studio 64 XTC 
stripes SMPTE according to the set-
tings (frame rate, start time, free 
wheel, and MTC routing) of the cur-
rent user program.

• Preset Program 3: ALL
When selected, all MIDI INs are 
routed to all MIDI OUTs.

• Preset Program 4: TUNE
When selected, continuous A440 note 
messages are sent to each port, 
which can be used to verify that 
instruments are connected, turned 
on, and set to the proper volume 
levels.

FRONT PANEL OPERATIONS

A variety of Studio 64 XTC operations can 
be accessed from the front panel. You can 
select user programs, access the preset 
functions, monitor and adjust sync set-
tings, and even initialize the factory user 
programs.

NOTE: Although a user program’s sync set-
tings can be adjusted from the front panel, 
to actually store these settings you must use 
your Macintosh or PC. 

For more information, see 
Chapter 8: Editing User Programs under 
Windows or Chapter 9: Editing User Pro-
grams on the Macintosh.

Selecting a Program

The PROGRAM button selects the cur-
rent program. Press this button once and 
an LED flashes rapidly to indicate the cur-
rently selected program. Press the 
PROGRAM button repeatedly to advance 
to and select a particular program.
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When either the TUNE or SMPTE pre-
sets are selected, pressing the 
PROGRAM button once will interrupt 
these routines and return to the previ-
ously selected program.

After the PANIC preset is selected and 
the “all notes off” messages are sent to 
each port, the Studio 64 XTC returns to 
the previously selected program.

Striping from the Front Panel

To begin striping SMPTE time code, 
simply select the SMPTE preset program. 
Time code is then automatically sent to 
the Studio 64 XTC’s SMPTE OUT jack; 
the frame rate used is that stored with the 
SMPTE settings of the previously 
selected program. The default user pro-
grams are each set to use 30-frame Non-
Drop with a Start Time of 00:00:00:00.

NOTE: Striping from the front panel 
always uses the SMPTE settings from the 
current user program.

To specify a particular format before strip-
ing, call up the SMPTE function and 
choose the desired frame rate with the 
SYNC button.

Monitoring/Editing Sync Settings

Settings for SMPTE, Sync Reference, and 
Sample Rate can be viewed from the front 
panel. To activate a sync function, push 
the PROGRAM button repeatedly until 
the desired function LED is lit.

When a particular sync function is 
selected, the sync status LEDs indicate its 
current state. Use the SYNC button to edit 
these sync settings by stepping through 
the various options. For an explanation of 
the three sync functions, see Sync Status 
LEDs (pg. 8).

Initializing User Programs

The user programs for the Studio 64 XTC 
are set to defaults at the factory. Using 
your Macintosh or IBM PC, these user 
programs can be edited to accommodate 
your specific needs.

If after making changes to the user pro-
grams you would like to return the 
Studio 64 XTC to its default state, you can 
initialize the unit with the following 
procedure:

a Turn off the Studio 64 XTC.

b Press the PROGRAM button and hold 
it down while turning the unit back on. 

Note that no LEDs are lit.

c After several seconds, release the 
PROGRAM button.

All LEDs flash four times, indicating the 
Studio 64 XTC user programs have 
been initialized.

IMPORTANT: Initializing the 
Studio 64 XTC is also recommended if, for 
some reason, the user programs become 
corrupted.
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CHAPTER 8: Editing User Programs under 
Windows

USING THE PROGRAM EDITOR

On the IBM PC, use the Studio 64 XTC 
Program Editor to display, edit, and 
store user programs.

To open the Program Editor:

a Locate the 64xtc.exe  program icon in 
the directory or folder specified 
during installation; then double-click 
it.

The Program Edit Window opens.

Figure 8.1: Program Edit Window for PC

The Program Editor is installed by run-
ning the Setup program from the 
provided PC disk. For more details, see 
Chapter 3: IBM PC Configuration.

Program Sets

The Studio 64 XTC’s four user programs 
are saved in files called “program sets.” 
On startup, the Program Editor reads the 
previously saved program set, which gen-
erally corresponds to the programs stored 
in the Studio 64 XTC’s nonvolatile 
memory.

If no program set exists, as when running 
the program for the first time, the Pro-
gram Editor automatically uses the 
default factory user programs.

While in the Program Editor, you can 
open previously saved program sets, 
create a new file from default settings, or 
send and retrieve program sets (or indi-
vidual programs) from the Studio 64 XTC.

Storing Changes

When making changes to a particular 
user program, the Program Editor echoes 
these changes to the edit buffer of the 
Studio 64 XTC. This way you can test out 
the new settings as they are edited.

However, to actually save these changes 
to nonvolatile memory you must use 
either Settings>Store Program or Set-
tings>Store All Programs. See Program 
Editor Menu Reference (pg. 36).

To open Program Editor,
double-click the 64xtc.exe icon
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PROGRAM EDIT WINDOW (PC)

The following section describes each 
component of the Program Edit Window.

Figure 8.2: Program Edit Window for PC

A Connection Grid: Defines connec-
tions, which route MIDI between 
inputs (on left) and outputs (on top). 
Click on any MIDI input or output to 
rename it.

Connections are indicated by MIDI 
connectors—black is selected and 
white unselected. Each connection 
may have its own set of filterings for 
MIDI messages and channels.

• To define a connection, click with the 
right mouse button on an empty grid 
location.

• To remove a connection, click on it 
with the right mouse button. 

• To select a connection, click on it 
with the left mouse button. 

• To select several connections, Con-
trol-click with the left mouse button 
on the desired connection(s).
In addition to the MIDI input and 
output ports, the Connection Grid 
also has a row and column for the 
Alesis ADAT. This allows routing of 
MMC to a connected ADAT (either 
from the computer or from an exter-
nal MIDI device).

B Message Filters: Specifies which 
MIDI messages are routed for the 
selected connection(s).

• A check mark indicates the mes-
sage is routed.

• No check mark indicates the 
message is not routed.

• A gray check mark indicates the 
message setting is different for the 
selected connections.

• Checking the “All” option automati-
cally routes all messages.

C Channel Filters: Specifies which 
channels are routed for the selected 
connection(s).

• A check mark indicates the chan-
nel is routed.

• No check mark indicates the 
channel is not routed.

• A gray check mark indicates the 
channel setting is different for the 
selected connections.

• Checking the “All” option automati-
cally routes all channels.

D Channel Bump: Shifts the channel 
assignment for MIDI messages for 
the selected connection(s).
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E Sync Reference: Determines the 
Sync Reference mode for the 
Studio 64 XTC. See Sync Reference 
Modes (pg. 50) for an explanation of 
each mode.

F Sample Rate: Determines the 
sample rate, and whether Pull Up/
Down is used, for the transmitted 
Word Clock and Super Clock. For 
details, see Word Clock and Super 
Clock (pg. 51).

G MTC Source: When the Sync Refer-
ence mode is specified as MTC or 
MTC/Video, this pop-up determines 
the source of the MTC (one of the 
four MIDI IN ports, or Computer).
Choose “Computer” as the source 
when receiving MTC from a software 
application. 
See MIDI Time Code (pg. 61) for 
details.

H Digital Phase Lock: When checked, 
this option provides the most accu-
rate sync when using Word Clock 
and Super Clock with digital audio 
hardware.
If, however, you are not using digital 
audio hardware, or an ADAT, 
uncheck this item for faster lock-up 
when syncing to SMPTE or MTC. 
For more information, see Digital 
Phase Lock (pg. 53).
NOTE: The Studio 64 XTC still gener-
ates Word/Super Clock when “Digital 
Phase Lock” is disabled. In this mode, 
however, audio sync is not as accurate.
IMPORTANT: Digital Phase Lock 
must be checked if you are controlling 
an Alesis ADAT from the 
Studio 64 XTC.

I ADAT Online: Determines whether 
the Studio 64 XTC sends control mes-
sages to a detected ADAT. For 
details, see Taking the ADAT Offline 
(pg. 66).

J Adat Offset: Specifies an offset for 
SMPTE transmitted to the ADAT 
Sync port. For details, see ADAT 
Offset (pg. 64).

K ADAT ID: Sets the ID for the ADAT 
connected directly to the 
Studio 64 XTC. For details, see 
ADAT ID (pg. 64).

L SMPTE Button: Opens the SMPTE 
Window.

M SMPTE Monitor: Displays scrolling 
SMPTE frames when receiving/gen-
erating time code. When receiving 
time code, the SMPTE monitor 
detects the frame rate.
NOTE: 29.97 Non-Drop is always 
detected as 30 Non-Drop.

N Program Name Field: Lets you type 
in a new name for the current 
program.

O Preset/User Programs Button: 
Specifies whether the preset or user 
programs are displayed.

P Program Buttons: Specifies which 
program is currently displayed and 
edited. Choosing a program also 
sends it to the edit buffer of the 
Studio 64 XTC, which does not store 
it in nonvolatile memory (to do this 
choose Settings>Store Current 
Program).

Q Status Field: Displays communica-
tion status between the 
Studio 64 XTC and PC.
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SMPTE Window

To open the SMPTE Window, click the 
SMPTE button in the Program Edit 
Window.

Figure 8.3: SMPTE Window for PC

Following is an explanation for each of the 
components in the SMPTE Window:

A SMPTE Monitor: Displays scrolling 
SMPTE frames when receiving/gen-
erating time code. When receiving 
time code, the SMPTE monitor 
detects the frame rate.
NOTE: 29.97 Non-Drop is always 
detected as 30 Non-Drop.

B SMPTE Start: Specifies the SMPTE 
start time when striping.

C Freewheel: Allows SMPTE synchro-
nization to continue (freewheel) 
when receiving bad time code. The 
Freewheel setting determines the 
number of dropped frames (None, 2, 
6, 10, 30, 60) the Studio 64 XTC will 
tolerate.
Choose “Jam Sync” if you would like 
the Studio 64 XTC to continue gener-
ating time code indefinitely when its 
SMPTE source has stopped.

D Format: Specifies the frame rate to 
be used when striping or generating 
SMPTE.

E Send MTC To: Directs MIDI Time 
Code (based on either received or 
generated SMPTE) to the computer 
and/or checked MIDI outputs.

F Stripe/Stop: Starts striping with the 
current SMPTE settings; click the 
button again to Stop.

G OK: Closes the SMPTE Window with 
the current settings.

NOTE: Settings in the SMPTE Window, 
along with those in the Program Edit Win-
dow, are saved with each user program. 
This lets you, for instance, save a different 
SMPTE format for each user program.

PROGRAM EDITOR MENU 
REFERENCE

After launching the Studio 64 XTC Pro-
gram Editor, the following menu items 
are available:

File>New

Opens a new program set with default 
settings.

File>Open

Opens a previously saved program set.
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File>Save

Saves the current program set with its 
current file name.

NOTE: This command does not save these 
programs to the nonvolatile memory of the 
Studio 64 XTC; to do this use 
Settings>Store All Programs.

File>Save As

Saves the current program set with a 
specified file name.

NOTE: This command does not save these 
programs to the nonvolatile memory of the 
Studio 64 XTC; to do this use 
Settings>Store All Programs.

File>Exit

Exits the Program Editor. If changes 
made to the current program set were not 
saved or sent to the Studio 64 XTC, you 
are prompted.

Edit>Copy Program

Copies the currently displayed program 
so it can be pasted into another program 
location or program set.

Edit>Paste Program

Pastes a user program into the current 
program location.

Settings>Name Program Set

Lets you specify a descriptive name for 
the current program set. The name 
appears in the Program Editor’s title bar 
along with the name of the current file.

Settings>Always On Top

When checked, ensures the Program Edit 
Window is always visually on top of any 
other open windows.

Settings>Store Current Program

Sends the currently displayed program to 
the Studio 64 XTC’s nonvolatile memory, 
where it is stored in the corresponding 
program location.

Settings>Retrieve Current Program

Retrieves the corresponding 
Studio 64 XTC user program from nonvol-
atile memory and updates the currently 
displayed program.

Settings>Store All Programs

Sends the current program set to the 
Studio 64 XTC where it is stored in non-
volatile memory.

Settings>Retrieve All Programs

Retrieves all four user programs from the 
Studio 64 XTC’s nonvolatile memory and 
places them in the current program set.
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Help>Quick Help

Displays help text on using the Program 
Editor.

Help>About Studio 64XTC Program 
Editor

Displays the version number for the Pro-
gram Editor, and ROM version for the 
Studio 64 XTC (which must be powered 
on and correctly connected).
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CHAPTER 9: Editing User Programs on the 
Macintosh

USING OMS SETUP

To display, edit, and store Studio 64 XTC 
user programs on the Macintosh, use the 
Program Edit Window from the 
OMS Setup application.

To open the Program Edit Window:

a Launch OMS Setup by double-
clicking its program icon.

b From within OMS Setup, choose 
Studio 64XTC>Edit Programs.

The Program Edit Window opens.

Figure 9.1: Program Edit Window for Mac

The Studio 64XTC menu is only avail-
able if the current OMS Studio Setup 
contains a Studio 64 XTC. For more 
details, see Chapter 4: Macintosh 
Configuration.

Program Sets

The Studio 64 XTC’s four user programs 
are saved in files called “program sets.” 
On startup, OMS Setup reads the previ-
ously saved program set, which generally 
corresponds to the programs stored in the 
Studio 64 XTC’s nonvolatile memory. If 
no program set exists, as when running 
the program for the first time, OMS Setup 
automatically uses the default factory user 
programs.

While in the Program Edit Window, you 
can open previously saved program sets, 
create a new file from default settings, and 
send and retrieve program sets (or indi-
vidual programs) from the Studio 64 XTC.

Storing Changes

When making changes to a particular 
user program in the Program Edit Win-
dow, these changes are echoed to the edit 
buffer of the Studio 64 XTC—thereby 
allowing you to try out the new settings as 
they are edited. 

However, to actually save these changes 
to nonvolatile memory, you must use 
either Studio 64XTC>Store Current 
Program or Studio 64XTC>Store All 
Programs. See Studio 64XTC Menu 
(pg. 42).
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PROGRAM EDIT WINDOW 
(MAC)

The following section describes each 
component of the Program Edit Window.

Figure 9.2: Program Edit Window for Macintosh

A Connection Grid: Defines connec-
tions, which route MIDI between 
inputs (located on the left) and out-
puts (located at the top); names for 
the MIDI inputs/outputs are taken 
from the current Studio Setup.

Connections are indicated by MIDI 
connectors—black is selected and 
white unselected. Each connection 
may have its own set of filterings for 
MIDI messages and channels.

• To define a connection, click and drag 
across empty grid locations.

• To select a connection, click and drag 
across the desired connector(s); to 
deselect, click anywhere outside the 
grid. 

• Click and drag while holding down 
the Shift key to add or remove from 
the “selection,” depending on 
whether the item clicked was 
selected.

• To disconnect a selected connection, 
click the scissors icon or type Back-
space, Delete or Clear. You may 
also remove a connection by double-
clicking it.
In addition to the MIDI input and 
output ports, the Connection Grid has 
a row and column for the Alesis 
ADAT. This allows routing of MMC 
to a connected ADAT (either from the 
computer or from an external MIDI 
device).
The Connection Grid can also route 
MTC (from the specified MTC 
Source) to any of the four MIDI OUT 
ports.

B Message Filters: Specifies which 
MIDI messages are routed for the 
selected connection(s).

• A green dot indicates the mes-
sage is routed.

• A red circle indicates the mes-
sage is not routed.

• A gray, empty area indicates the 
message setting is different for the 
selected connections.

• Selecting the “All” option automati-
cally routes all messages.
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C Channel Filters: Specifies which 
channels are routed for the selected 
connection(s).

• A green dot indicates the channel 
is routed.

• A red circle indicates the channel 
is not routed.

• A gray, empty area indicates the 
channel setting is different for the 
selected connections.

• Selecting the “All” option automati-
cally routes all channels.

D Channel Bump: Shifts the channel 
assignment for MIDI messages for 
the selected connection(s).

E Rename button: Lets you rename 
the current user program.

F Program pop-up: Specifies which 
program is being displayed and 
edited. Choosing a program from this 
pop-up menu also sends it to the edit 
buffer of the Studio 64 XTC, which 
does not store it in nonvolatile 
memory (to do this choose 
Studio 64XTC>Store Program).

G Digital Phase Lock: When checked, 
this option provides the most accu-
rate sync when using Word Clock 
and Super Clock with digital audio 
hardware.
If, however, you are not using digital 
audio hardware or an ADAT, uncheck 
this item for faster lock-up when sync-
ing to SMPTE or MTC. For more 
info, see Digital Phase Lock (pg. 53).
NOTE: The Studio 64 XTC still gener-
ates Word/Super Clock when “Digital 
Phase Lock” is disabled. In this mode, 
however, audio sync is not as accurate.

IMPORTANT: Digital Phase Lock 
must be checked if you are controlling 
an Alesis ADAT from the 
Studio 64 XTC.

H Sample Rate: Determines the 
sample rate, and whether Pull Up/
Down is used, for the transmitted 
Word Clock and Super Clock. For 
details, see Word Clock and Super 
Clock (pg. 51).

I Sync Source: Determines the Sync 
Reference mode for the 
Studio 64 XTC. See Sync Reference 
Modes (pg. 50) for an explanation of 
each mode.

J MTC Source: When the Sync Refer-
ence mode is specified as MTC or 
MTC/Video, this pop-up determines 
the source of the MTC (one of the 
four MIDI IN ports, or Computer).
Choose “Computer” as the source 
when receiving MTC from a software 
application.
See MIDI Time Code (pg. 61) for 
details.

K Adat Offset: Specifies an offset for 
SMPTE transmitted to the ADAT 
Sync port. For details, see ADAT 
Offset (pg. 64).
ADAT ID: Sets the ID for the ADAT 
connected directly to the 
Studio 64 XTC. For details, see 
ADAT ID (pg. 64).
ADAT Online: Determines whether 
the Studio 64 XTC sends control mes-
sages to a detected ADAT. For 
details, see Taking the ADAT Offline 
(pg. 66).
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SMPTE Window

To open the SMPTE Window, choose 
Studio 64XTC>SMPTE Window.

Figure 9.3: SMPTE Window for Mac

Following is an explanation for each of the 
components in the SMPTE Window:

A SMPTE Monitor: Displays scrolling 
SMPTE frames when either receiving 
or generating time code. When 
receiving time code, the SMPTE 
monitor detects the frame rate.
NOTE: 29.97 Non-Drop is always 
detected as 30 Non-Drop.

B Freewheel: Allows SMPTE synchro-
nization to continue (freewheel) 
when receiving bad time code. The 
Freewheel setting determines the 
number of dropped frames (None, 2, 
6, 10, 30, 60) the Studio 64 XTC will 
tolerate.
Choose “Jam Sync” if you would like 
the Studio 64 XTC to continue gener-
ating time code indefinitely when its 
SMPTE source has stopped.

C Start Time: Specifies the SMPTE 
start time when striping.

D Format: Specifies the frame rate to 
be used for striping SMPTE.

E Start Striping Button: Starts strip-
ing with the current SMPTE settings; 
to stop, click the Stop Striping button. 

F Stop Striping Button: Stops SMPTE 
striping; to begin striping SMPTE, 
click the Start Striping button.

NOTE: Settings in the SMPTE Window, 
along with those in the Program Edit Win-
dow, are saved with each user program. 
This lets you, for instance, save a different 
SMPTE format for each user program.

STUDIO 64XTC MENU

When the current OMS Studio Setup con-
tains a Studio 64 XTC, a Studio 64XTC 
menu becomes available with the follow-
ing items:

Studio 64XTC>Edit Programs

Opens the Program Edit Window, which 
displays and edits user programs.

Studio 64XTC>SMPTE

Opens the SMPTE Window, from which 
SMPTE may be read or generated.

Studio 64XTC>Open

Opens a previously saved program set.
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Studio 64XTC>Save

Saves the current program set with its 
current file name.

NOTE: This command does not save these 
programs to the nonvolatile memory of the 
Studio 64 XTC; to do this choose 
Studio 64XTC>Store All Programs.

Studio 64XTC>Save As

Saves the current program set with a 
specified file name.

NOTE: This command does not save these 
programs to the nonvolatile memory of the 
Studio 64 XTC; to do this choose 
Studio 64XTC>Store All Programs.

Studio 64XTC>Copy Program

When the Program Edit Window is open, 
copies the currently displayed program so 
it can be pasted into another program 
location or program set.

Studio 64XTC>Paste Program

When the Program Edit Window is open, 
pastes a user program into the current 
program location.

Studio 64XTC>Load Current Program

Retrieves the corresponding 
Studio 64 XTC user program from nonvol-
atile memory and updates the currently 
displayed program.

Studio 64XTC>Store Current Program

Sends the currently displayed program to 
the Studio 64 XTC’s nonvolatile memory, 
where it is stored in the corresponding 
program location.

Studio 64XTC>Load All Programs

Retrieves all four user programs from the 
Studio 64 XTC’s nonvolatile memory and 
places them in the current program set.

Studio 64XTC>Store All Programs

Sends the current program set to the 
Studio 64 XTC where it is stored in non-
volatile memory.

Studio 64XTC>Display ROM Version

Displays the ROM version for the 
Studio 64 XTC, which must be powered 
on and correctly connected.
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CHAPTER 10: Synchronization Basics

The Studio 64 XTC can synchronize a 
variety of different audio equipment, 
including computer sequencers, multi-
track analog recorders, digital 
multitracks, hard disk recorders, MMC 
devices, and video decks.

The Studio 64 XTC’s sync settings specify 
how all of these devices are kept in sync, 
which devices are timing sources and 
which are slaves.

Before exploring how the Studio 64 XTC 
works with these various sync devices, we 
should first examine the basics of SMPTE 
time code—the most fundamental compo-
nent of synchronization.

ABOUT SMPTE

SMPTE is a timing reference signal devel-
oped by the Society of Motion Pictures 
and Television Engineers. It specifies a 
format for recording digital timing infor-
mation onto magnetic tape. Originally 
designed for keeping film and video in 
sync with audio, it is now commonly used 
in a variety of audio specific applications.

A common scenario involving SMPTE 
and MIDI entails synchronizing MIDI 
tracks from a software sequencer with 
music tracks from a multitrack recorder. 
A tape track is striped with SMPTE time 
code and then read back into the com-
puter—usually by a MIDI interface with 
sync capabilities. The time code provides 
a reference to the sequencer of where the 
tape is at any precise moment, allowing 
tape events to synchronize with sequence 
events.

Following are some SMPTE terms with 
which you should become familiar.
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Synchronization

The means by which two or more signals 
are locked together in time. One example 
is how the frames in a film line up with the 
audio track—thereby ensuring that what 
you hear is synchronized with what you 
see.

SMPTE Time Code

A digital signal, comprised of timing infor-
mation, that is recorded onto magnetic 
tape (multitrack recorders, video decks, 
film, etc.). As illustrated in Figure 10.1, 
consecutive time code frames mark loca-
tions in hours, minutes, seconds, and 
frames (subdivisions of a second).

Figure 10.1: SMPTE time code frames

SMPTE Sync Track

A region of tape onto which is recorded 
SMPTE time code for the purpose of syn-
chronization. The time code provides a 
reference for the occurrence of specific 
tape events.

Figure 10.2: SMPTE sync track

SMPTE Formats

The Studio 64 XTC supports five SMPTE 
frame rates, which include:

• 30 Frame/second (Non-Drop): Origi-
nal NTSC black and white television 
standard. This format is often used in 
audio-specific applications since there 
are no dropped frames and the 
SMPTE time is equal to real time.

• 29.97 Frames/second (Non-Drop): 
Syncs to NTSC color television with-
out dropping frames. SMPTE time 
does not match real time, but play-
back pitch is unaffected.

• 29.97 Drop Frame: NTSC (North 
American) color television frame rate. 
This format runs at 30 Frame/sec-
ond, but has the first two frames 
dropped every minute, except at min-
utes 0, 10, 20, 30, 40 and 50.

• 25 Frames/second: EBU (European) 
television frame rate.

• 24 Frames/second: Film frame rate.

SMPTE Start Time

The time represented by the first frame of 
time code recorded on a SMPTE sync 
track. The sync track should be recorded 
so that the start time precedes the offset 
by at least three seconds.

SMPTE Offset

The SMPTE time (location) on tape that 
corresponds to the beginning of a song or 
musical passage. The offset time should 
occur at least three seconds after the 
SMPTE start time.
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MIDI Time Code (MTC)

SMPTE time code that has been con-
verted to MIDI messages for 
communication between MIDI devices 
and software.

Freewheel

A method by which a MIDI interface (or 
sync device) continues to generate time 
code when there is no SMPTE signal 
present. This is very useful when attempt-
ing to sync to a tape containing bad time 
code (yielding dropouts in the SMPTE 
signal).

TIME BASE AND ADDRESS

There are two basic components involved 
in accurately synchronizing multiple 
devices for audio playback: address and 
time base.

Address specifies location, which ensures 
that all devices begin playing from a pre-
cise (SMPTE) location.

Time base provides an accurate measure-
ment of time passage—thereby making 
sure the duration of audio events is the 
same (in sync) for all playback devices.

The Studio 64 XTC’s primary purpose is 
to resolve the address and time base 
sources and generate accurate Word/
Super Clock, SMPTE time code, and 
MTC—which, as a result, synchronizes 
all audio devices.

An important thing to remember about 
address and time base is that sometimes 
(although not always) these sources will 
come from two different sync devices. For 
instance, it is very common to receive 
SMPTE (address) from a video deck 
while receiving Blackburst (time base) 
from a house sync source.

Blackburst and Video Signals

Blackburst and composite video signals 
allow video equipment to transfer video 
images and also stay in sync with each 
other (frame-locked).

Consumer VCRs and televisions use com-
posite video to send and receive video 
signals. Blackburst, on the other hand, 
sometimes referred to as house sync, is a 
more accurate video signal used by high-
end, professional video decks.

A Blackburst generator is used in video 
production studios to provide a master 
sync reference to all video devices, which 
allows all equipment to be frame-locked.

The Studio 64 XTC accepts both Black-
burst and composite video sync. This 
allows video decks to accurately synchro-
nize with MIDI sequencing software, 
digital multitracks, and hard disk 
recorders.

See Using Blackburst/Video Sync (pg. 71) 
for a discussion of several Studio 64 XTC 
scenarios with video sync.
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SYNC REFERENCE MODES

The Studio 64 XTC’s Sync Reference set-
ting specifies the sources for address and 
time base.

The following table illustrates the address 
and time base for each of the Sync Refer-
ence modes for the Studio 64 XTC:

Table 1: Studio 64 XTC Sync Reference Modes

The Sync Reference mode can be set from 
the front panel using the PROGRAM and 
SYNC buttons. See Front Panel Opera-
tions (pg. 31).

The Sync Reference mode can also be set 
from the Program Edit Window using 
either your PC (see Chapter 8, pg. 33) or 
Macintosh (see Chapter 9, pg. 39).

The following sections discuss each of the 
Studio 64 XTC’s Sync Reference modes:

Internal

Use Internal when you are not referenc-
ing an external SMPTE or MTC source. If 
you are controlling an Alesis ADAT with-
out involving any other tape or video 
devices, you should use Internal. In this 
mode, the Studio 64 XTC acts as the 
source for both address and time base.

Internal/Video

This mode is used when syncing to either 
a Blackburst or composite video signal 
without referencing an external SMPTE 
or MTC source. This mode should also be 
used when you wish to stripe frame-
locked SMPTE time code onto video.

SMPTE

Choose this mode when receiving 
SMPTE time code from the SMPTE IN 
jack of the Studio 64 XTC. The source of 
the time code in this instance would likely 
be a multitrack recorder—not video.

SMPTE/Video

This mode is used for locking to a Black-
burst or composite video signal while also 
receiving SMPTE time code. 

The SMPTE source may come from the 
video deck providing the composite video 
signal.

Sync Mode Address
Time 
Base

Internal 64XTC 64XTC

Int/Video 64XTC Video

SMPTE SMPTE SMPTE

SMPTE/Video SMPTE Video

MTC MTC MTC

MTC/Video MTC Video
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MTC

Choose this mode when receiving MTC 
from one of the MIDI IN jacks of the 
Studio 64 XTC, or from a software pro-
gram on your Mac or PC.

Keep in mind that in order for this to 
work, the current user program must 
specify the desired MTC Source (Com-
puter, or one of the four MIDI inputs).

MTC/Video

This mode is used for locking to a Black-
burst or composite video signal while 
using MTC (received from one of the 
Studio 64 XTC’s MIDI inputs, or from a 
software program) as the source address.

WORD CLOCK AND SUPER 
CLOCK

The advent of digital audio has necessi-
tated the need for an accurate, stable time 
base.

Although a precise address source 
(SMPTE) ensures that digital audio, from 
either digital multitracks or hard disk 
recorders, will begin playing at the cor-
rect time (location), that alone does not 
guarantee a phase-lock relationship.

Because the speed of SMPTE sources will 
sometimes vary or fluctuate, the material 
on tape (or video) will likely drift out of 
sync with digital audio events.

This problem is alleviated when a stable 
time base source is introduced into the 
equation. Since the time base accurately 
determines how long it takes to get from 
one SMPTE location to another, digital 
audio playback can then be slowed down 
or sped up (without its pitch being notice-
ably affected) to ensure a true phase-lock 
relationship.

The speed and pitch of audio playback is 
controlled by the Studio 64 XTC’s Word 
Clock and Super Clock outputs. Word 
Clock can be sent to digital multitracks, 
hard disk recorders, and DAT machines 
(provided they accept Word Clock input). 
Super Clock is Digidesign’s proprietary 
sync format used with their professional 
digital audio cards and interfaces.

NOTE: No matter which of the 
Studio 64 XTC’s Sync Reference modes is 
active, Word Clock and Super Clock are 
always generated.

Sample Rate

The Studio 64 XTC’s Sample Rate setting 
affects the Word Clock and Super Clock 
generated. This setting must match the 
sample rate with which your particular 
audio hardware is configured.

The following choices are available for the 
Studio 64 XTC’s sample rate setting:

• 44.1 kHz: The industry standard 
sample rate for audio CDs.

• 48 kHz: The sample rate featured on 
most professional DAT recorders. It 
is also the default rate used by Alesis 
ADATs.
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If you are unsure of the sample rate used 
by your particular digital audio hardware, 
please consult the manufacturer’s manual.

NOTE: Changing the Studio 64 XTC’s 
sample rate setting does not automatically 
set the rate for connected digital audio 
hardware.

For information on adjusting the sample 
rate of your digital audio hardware, consult 
the manufacturer’s documentation.

NOTE: If using an Alesis ADAT or Tascam 
DA-88, make sure the Sample Rate for the 
Studio 64 XTC matches the rate used when 
formatting your audio tapes.

Pull Up/Down Setting

Pull Up and Pull Down adjust the audio 
sample rate to compensate for speed 
changes that occur when transferring 
between film and video.

It is very common when scoring for film 
that a working video tape is created with a 
process called Telecine. The Telecine pro-
cess transfers the film, running at 24 fps, 
to video tape running at 30 fps. Recording 
at 30 fps ensures that no frames (or partial 
frames) are lost in the transfer.

Unfortunately, playing this video on 
NTSC video decks, which run at a speed 
of 29.97 fps, results in a slowed-down play-
back. In addition, the tape’s audio also 
plays slower—thereby making the pitch 
slightly flat. This pulled-down audio is 
often referred to as playing at “tape 
speed” (as opposed to the original “film 
speed”).

When to Use Pull Up

If working with a video tape that plays at 
“tape speed,” you can activate the 
Studio 64 XTC’s Pull Up mode when 
recording the tape’s audio with your digi-
tal audio hardware. After recording, 
disable the Pull Up mode and the trans-
ferred audio will play back at “film speed.”

Once you have a scratch track at “film 
speed,” you can record additional location 
audio or dialog as needed.

When to Use Pull Down

If you have digital audio tracks at “film 
speed” and you are syncing to a video 
tape that’s playing at “tape speed,” the two 
will drift out of sync and also play back at 
different pitches.

To get around this problem, activate the 
Studio 64 XTC’s Pull Down mode to 
adjust the playback of your digital audio 
hardware—thereby ensuring it is in sync 
with the material playing at “tape speed.”

LOCK-UP TIME

When syncing to SMPTE or MTC, the 
Studio 64 XTC waits about 5-10 seconds 
for sync to stabilize before transmitting 
MTC to your music software. This means 
that there will be a delay between the time 
the Studio 64 XTC receives time code and 
the time your software begins playing.
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You may wish to allow adequate pre-roll 
time (about 10 seconds) on your SMPTE 
source so your software begins playing at 
the desired time.

Unfortunately, this time it takes to lock-up 
with external time code is necessary to 
provide the most accurate sync between 
digital audio devices.

NOTE: The 5-10 second lock-up time 
applies only if Digital Phase Lock is 
enabled for the Studio 64 XTC, see the fol-
lowing section for details.

Digital Phase Lock

If you are not using digital audio hardware 
or an ADAT, you can disable Digital 
Phase Lock for faster lock-up when sync-
ing to SMPTE or MTC. This sync option 
is stored in each user program and can be 
disabled/enabled from the Program Edit 
Window of your Mac or PC software. 

When enabled, the Digital Phase Lock 
option provides the most accurate sync 
when using Word Clock and Super Clock 
with digital audio hardware.

NOTE: The Studio 64 XTC still generates 
Word/Super Clock when “Digital Phase 
Lock” is disabled. In this mode, however, 
audio sync is not as accurate.

IMPORTANT: Digital Phase Lock must be 
enabled if you are controlling an Alesis 
ADAT from the Studio 64 XTC’s ADAT 
Sync port.

There are, however, a few differences in 
the way the Studio 64 XTC behaves when 
Digital Phase Lock is disabled.

Specifically, if Digital Phase Lock is off 
and the Sync Reference mode is set to 
MTC or MTC/Video...

• SMPTE is not generated and sent to 
the SMPTE OUT jack.

• For Mac users, MTC from your soft-
ware is automatically sent to all MIDI 
OUT ports, and to networked inter-
faces—when the MTC Source is 
“Computer.”
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CHAPTER 11: Working with SMPTE and MTC

STUDIO 64 XTC AND SMPTE

The Studio 64 XTC can either stripe or 
sync to SMPTE. Whether the unit is gen-
erating or receiving SMPTE is indicated 
by the status LEDs (when the SMPTE 
function is chosen from the front panel). 
A status LED, indicating the frame rate, 
blinks slowly when the Studio 64 XTC is 
generating SMPTE, or flashes rapidly 
when receiving SMPTE.

IMPORTANT: In order for the 
Studio 64 XTC to read SMPTE at its 
SMPTE IN jack, the Sync Reference mode 
must be set to either “SMPTE” or “SMPTE/
Video.”

How the Studio 64 XTC Stripes 
SMPTE

The Studio 64 XTC can stripe SMPTE by 
selecting the SMPTE preset program 
with the PROGRAM button (see Front 
Panel Operations (pg. 31)). The SMPTE 
settings used are those stored in the cur-
rent user program.

The Studio 64 XTC can also stripe 
SMPTE from the SMPTE Window 
(accessed from the Program Editor on 
the PC, or OMS Setup on the Mac).

While striping SMPTE, the Studio 64 XTC 
can also transmit MTC to your computer 
and/or MIDI outputs (based on the MTC 
destinations specified in the current user 
program). 

NOTE: To facilitate setting levels, the 
Studio 64 XTC emits a constant leader 
tone when not striping. This leader tone 
cannot be disabled.

How the Studio 64 XTC Reads 
SMPTE

The SMPTE IN jack of the Studio 64 XTC 
reads time code directly from a sync 
source, such as a tape track. Upon recep-
tion of SMPTE, the Studio 64 XTC 
automatically determines the frame rate 
and after 5-10 seconds (typical lock-up 
time with Digital Phase Lock on), the 
appropriate status LED flashes rapidly. 

Remember, this only takes place if the 
Studio 64 XTC’s Sync Reference mode is 
set to SMPTE or SMPTE/Video.

After initial lock-up, the Studio 64 XTC 
communicates MTC to your computer 
and MIDI outputs as specified in the cur-
rent user program. In addition, time code 
is regenerated and sent out the SMPTE 
OUT jack.
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Reading 29.97 Non-Drop

When receiving 29.97ND, the 
Studio 64 XTC always detects it as 30ND. 
It is not possible for hardware or software 
to tell the difference between these two 
SMPTE formats.

For proper synchronization to 29.97ND, 
make sure that the Studio 64 XTC’s cur-
rent user program and your music 
software are both set to this format.

SMPTE Freewheel

The Studio 64 XTC provides dropout pro-
tection on SMPTE input. This allows a 
sequencer or other program to reliably 
sync to SMPTE even when receiving cor-
rupted time code (such as from tape 
dropout). The Freewheel setting in the 
SMPTE Window determines the number 
of dropped frames (None, 2, 6, 10, 30, 60) 
the Studio 64 XTC will tolerate. The 
default Freewheel setting is 10 frames.

NOTE: Because the Studio 64 XTC cannot 
distinguish between bad time code and time 
code that has merely stopped, your MIDI 
sequencer will continue to sync for a brief 
time after the tape has stopped.

Jam Sync

When the Studio 64 XTC reads incoming 
SMPTE, it regenerates identical time 
code to the SMPTE OUT jack. Regenera-
tion allows re-striping of a damaged sync 
track or “bouncing” from one sync track 
to another.

In the case of a severely damaged sync 
track, or if you need to extend the length 
of a sync track, the Studio 64 XTC can use 
Jam Sync (a Freewheel setting in the 
SMPTE Window). When Jam Sync is 
enabled and the Studio 64 XTC locks onto 
time code, it will regenerate SMPTE 
indefinitely.

SMPTE CONNECTIONS

The Studio 64 XTC has SMPTE IN and 
OUT jacks for direct connection to multi-
track tape recorders, video decks, and 
other equipment capable of receiving/
transmitting sync information. The sync 
signals are output as line-level audio, so 
special equipment is not required.

In general, SMPTE signals should bypass 
mixing consoles, equalizers, and any 
other signal processing equipment that 
could add distortion to the signals and 
affect synchronization. For connections, 
use shielded audio cables with 1/4” 
phone plug termination.

IMPORTANT: An optimum SMPTE signal 
has a level between -10 db and -3 db, and 
should not be processed by equalization, 
compression/limiting, or noise reduction.
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SMPTE OUT Connection

When striping a tape, connect the SMPTE 
OUT jack of the Studio 64 XTC to the 
audio input of the tape deck (either the 
sync input or the last track).

Figure 11.1: Recording SMPTE to track 8 of 
multitrack

NOTE: To facilitate setting levels, the 
Studio 64 XTC emits a constant leader 
tone when not striping.

SMPTE IN Connection

When syncing to tape, connect the 
SMPTE IN jack of the Studio 64 XTC to 
the audio output of the tape deck’s 
SMPTE track.

Figure 11.2: Receiving SMPTE from multitrack

NOTE: After locking on to the incoming 
SMPTE time code, the time code is then 
regenerated and sent to the SMPTE OUT 
jack.

Studio 64 XTC

Multitrack
SMPTE out

Track 8 input

Studio 64 XTC

Multitrack
SMPTE in

Track 8 output
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STRIPING/SYNCING TO TAPE 
UNDER WINDOWS

Before beginning the following sections 
you must install and configure the Win-
dows driver for the Studio 64 XTC.

Striping with Program Editor (PC)

To stripe SMPTE from within the Pro-
gram Editor on the PC:

a Make sure your tape deck is 
connected to the Studio 64 XTC as 
specified in SMPTE Connections 
(pg. 56). 

Always record to the first or last tape 
track, this minimizes sync signal bleed-
through to adjacent tracks.

b Set record levels to between -10db 
and -3db, according to your 
equipment’s needs.

To facilitate setting levels, the 
Studio 64 XTC emits a constant leader 
tone when not striping. 

If applicable, defeat noise reduction and 
equalization for the sync track.

c Open the Program Editor by double-
clicking the 64xtc.exe  icon. Then click 
the SMPTE button to open the 
SMPTE Window.

Figure 11.3: SMPTE Window for PC

d Choose the desired SMPTE Format 
by clicking on the appropriate radio 
button. 

If you’re using a multitrack recorder and 
do not expect others to sync to your 
tape, a format of “30 Non-Drop” will suf-
fice. When working with a studio or other 
third parties, consult them to determine 
their requirements.

e Specify the SMPTE Start Time. 

Unless you have a specific reason to use 
a different time, you can safely choose 
00:00:00:00.

f Choose any desired MTC 
destination(s). 

In most cases you will only send MTC to 
the computer, which enables the Pro-
gram Editor’s SMPTE Monitor to display 
the generated time code.

g Place your tape deck in record mode 
and start the tape rolling.

h After recording 3-4 seconds of just 
the leader tone, click the Stripe 
button.

i Allow sufficient time for the sync 
track to be recorded. It is a good idea 
to provide a minute or two of extra 
margin so the sync track duration is 
longer than the MIDI sequence. 

To stop generating SMPTE, click Stop 
or OK.
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Syncing to Tape (PC)

Although details will vary from one pro-
gram to the next, use the following steps 
to synchronize your Windows MIDI soft-
ware to tape (consult your software’s user 
manual for more info):

a Make sure connections between your 
tape deck and the Studio 64 XTC are 
as specified in SMPTE Connections 
(pg. 56).

b Set tape playback levels to between 
-10 db and -3 db. 

If applicable, defeat any noise reduction 
or equalization settings affecting the 
sync track.

c Set the Studio 64 XTC’s Sync 
Reference mode to SMPTE.

If using Blackburst or video as the time 
base source, set the Sync Reference 
mode to “SMPTE/Video.”

d Launch your MIDI sequencing 
software. If you are using an existing 
song file, open it; if recording a new 
song, set it to the desired tempo.

e Set your sequencer’s sync source to 
the 64XTC Sync Port.

If using an OMS application under Win-
dows, such as Vision 2.5.1, the sync port 
for the Studio 64 XTC is “Port 6” (as 
defined in OMS Setup).

f Configure your sequencer to sync to 
SMPTE (or MTC) and specify the 
SMPTE format and offset time.

g Put your sequencer in play or record 
mode.

Many programs display a “Waiting for 
Sync” message.

h Start the tape rolling at the desired 
location.

After 5-10 seconds (typical lock-up time 
with Digital Phase Lock on), the 
sequencer automatically begins playing 
or recording from the tape’s location.

The sequencer tracks remain locked to 
the material on tape until either the tape 
or the software is stopped.

STRIPING/SYNCING TO TAPE 
ON THE MACINTOSH

Before beginning the following sections, 
OMS must be installed and configured.

Striping with OMS Setup (Mac)

To stripe SMPTE from within the 
OMS Setup program on the Mac:

a Make sure your tape deck is 
connected to the Studio 64 XTC as 
specified in SMPTE Connections 
(pg. 56). 

Always record to the first or last tape 
track, this minimizes sync signal bleed-
through to adjacent tracks.

b Set record levels to between -10db 
and -3db, according to your 
equipment’s needs 

To facilitate setting levels, the 
Studio 64 XTC emits a constant leader 
tone when not striping.

If applicable, defeat noise reduction and 
equalization for the sync track.
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c Launch the OMS Setup program and 
choose Studio 64XTC>SMPTE to 
open the SMPTE Window. 

Figure 11.4: SMPTE Window for Mac

The Studio 64XTC menu is only avail-
able when your current Studio Setup 
contains a Studio 64 XTC.

d Choose the desired SMPTE Format 
from the pop-up menu. 

If you’re using a multitrack recorder and 
do not expect others to sync to your 
tape, a format of “30 Non-Drop” will suf-
fice. When working with a studio or other 
third parties, consult them to determine 
their requirements.

e Specify the SMPTE Start Time. 

Unless you have a specific reason to use 
a different time, you can safely choose 
00:00:00:00.

f Place your tape deck in record mode 
and start the tape rolling. 

g After recording 3-4 seconds of just 
the leader tone, click Start Striping.

h Allow sufficient time for the sync 
track to be recorded. It is a good idea 
to provide a minute or two of extra 
margin so the sync track duration is 
longer than the MIDI sequence. 

To stop generating SMPTE, click Stop 
Striping.

Syncing to Tape (Mac)

Although details will vary from one pro-
gram to the next, use the following steps 
to synchronize your Macintosh MIDI 
sequencer to tape (consult your soft-
ware’s user manual for more info):

a Make sure connections between your 
tape deck and the Studio 64 XTC are 
as specified in SMPTE Connections 
(pg. 56).

b Set tape playback levels to between 
-10 db and -3 db. 

If applicable, defeat any noise reduction 
or equalization settings affecting the 
sync track.

c Set the Studio 64 XTC’s Sync 
Reference mode to SMPTE.

If using Blackburst or video as the time 
base source, set the Sync Reference 
mode to “SMPTE/Video.”

d Launch your MIDI sequencing 
software. If using an existing song, 
open it; if recording a new song, set it 
to the desired tempo.

e Set your sequencer’s sync source to 
the Studio 64XTC.

f Configure your sequencer to sync to 
SMPTE (or MTC) and specify the 
SMPTE format and offset time.

g Put your sequencer in play or record 
mode.

Many programs display a “Waiting for 
Sync” message.
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h Start the tape rolling at the desired 
location.

After 5-10 seconds (typical lock-up time 
with Digital Phase Lock on), the 
sequencer automatically begins playing 
or recording from the tape’s location. 

The sequencer tracks remain locked to 
the material on tape until either the tape 
or the software is stopped.

GENERATING SMPTE

The Studio 64 XTC is one of the few MIDI 
interfaces that can actually generate 
SMPTE time code while playing and 
recording from your MIDI sequencing or 
audio recording software. 

Note that this is not the same as when 
striping a tape with SMPTE—though in 
both instances time code is actually sent 
to the Studio 64 XTC’s SMPTE OUT jack.

When “generating” SMPTE, the gener-
ated timecode is sent along with (and in 
sync with) the Word/Super Clock sent to 
the audio devices, and the MTC sent to 
the computer. 

This is very useful for transmitting 
SMPTE time code to external devices like 
automated mixers and digital recorders 
that “chase lock” SMPTE time code.

NOTE: Regardless of the Studio 64 XTC’s 
Sync Reference mode, the unit almost 
always generates SMPTE time code when it 
is sending sync information.

However, if the Sync Reference mode is 
MTC or MTC/Video and “Digital Phase 
Lock” is off, SMPTE time code is not 
generated.

MIDI TIME CODE

In addition to syncing to SMPTE time 
code via the SMPTE IN jack, the 
Studio 64 XTC can also sync to MTC. In 
this scenario the Studio 64 XTC’s Sync 
Reference mode must be set to MTC or 
MTC/Video.

The MTC Source, which is specified in 
the current user program, can be one of 
the four MIDI INs, or the Computer (if 
receiving MTC from a software 
application). 

Generating MTC

Regardless of the Studio 64 XTC’s Sync 
Reference mode, the interface always gen-
erates MTC when generating sync 
information. 

In most cases, the destination for the 
MTC will be the “Computer,” as when 
using software for MIDI sequencing or 
digital audio recording.
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However, the generated MTC can also be 
sent to any of the four MIDI OUTs as 
determined by the current user program 
for the Studio 64 XTC.

On the PC, MTC destination ports are 
specified in the Program Editor’s SMPTE 
Window.

Figure 11.5: SMPTE Window (PC), MTC routed to 
Computer and Port 2

On the Mac, MTC destination ports are 
specified in the Connection Grid.

Figure 11.6: Connection Grid (Mac), MTC routed to 
Computer and Port 2

Sending MTC from MIDI Software (with 
Digital Phase Lock off)

If you wish to send MTC from a MIDI 
software application and you are not using 
Digital Phase Lock (i.e. you are not using 
digital audio hardware or an ADAT), the 
Studio 64 XTC can automatically direct 
the MTC to all MIDI OUTs.

To do this, set the Sync Reference mode 
for the Studio 64 XTC to MTC with the 
MTC Source set to Computer (remem-
ber, make sure that Digital Phase Lock is 
disabled). 

Then in your MIDI application direct the 
MTC to the Studio 64 XTC (on the PC, 
specify the destination as the “64XTC 
Broadcast Port”). 

The end result of this scenario is that 
MTC from the software is sent to all MIDI 
OUTs (and to any Networked interfaces).

NOTE: If you don’t want MTC sent to all 
MIDI OUTs, use the Connection Grid in 
the Program Edit Window to mute MTC for 
each desired OUT.
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CHAPTER 12: ADATs and other MMC Devices

The Studio 64 XTC turns your personal 
computer into a remote control center for 
Alesis ADATs and MIDI Machine Control 
(MMC) devices.

ABOUT MIDI MACHINE 
CONTROL

With the Studio 64 XTC and the appropri-
ate MIDI software, your computer can 
use MMC commands to control the trans-
ports of compatible recording devices.

MMC instructs your recording device(s) 
to play, record, pause, stop, fast-forward, 
rewind, and even record-enable tracks. 
This makes it very easy to integrate exter-
nal multitracks and hard disk recorders 
with computer sequencing or digital 
recording software—thereby using a 
single transport to control the playback 
and recording of many devices.

WORKING WITH ALESIS ADATS

Slaving Alesis ADATs from the 
Studio 64 XTC requires very little in the 
way of setup and configuration.

Figure 12.1: Controlling one or more ADATs from the 
Studio 64 XTC

All the information necessary for control-
ling ADATs is communicated from the 
Studio 64 XTC’s ADAT Sync port. What’s 
more, additional ADATS can be daisy-
chained and the Studio 64 XTC will easily 
control them as well.

Studio 64 XTC

Alesis ADAT, Device 1

ADAT Sync

Sync In

Additional ADATs, daisy-chained
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ADAT ID and Offset

Stored with each Studio 64 XTC user pro-
gram are ADAT settings for ID and 
offset. These two settings cannot be 
edited from the Studio 64 XTC’s front 
panel; if you wish to change them you 
must therefore use the included PC or 
Macintosh software.

Figure 12.2: Sync settings from Program Editor (PC)

Figure 12.3: Sync settings from OMS Setup (Mac)

ADAT ID

When an ADAT is connected to the 
Studio 64 XTC, its ID is automatically 
configured to the ID setting stored in the 
current user program. If more than one 
ADAT is connected, each unit’s ID is con-
figured incrementally (for instance, first 
ADAT set to “0,” next ADAT set to “1”).

It is important that the ADAT ID setting in 
your user programs match the ID speci-
fied in your sequencing software. If you 
are using OMS, make sure the device 
defined as your ADAT is also set to that 
ID.

IMPORTANT: The ID numbering scheme 
for the Alesis ADAT is off by one. For 
instance, if your Studio 64 XTC user pro-
gram is set to “0,” the front panel of your 
ADAT will actually display “1.”

ADAT Offset

The ADAT offset only affects location 
information sent to the ADATs (from the 
Studio 64 XTC’s ADAT Sync port). This 
allows you to have the ADAT play any 
location on the tape relative to incoming 
time code. The offset is needed because 
ADAT tapes only provide about 40 
minutes of play time, while time code 
could come in at any time within a 24 hour 
range.

For instance, suppose you were trying to 
sync to something on video that began at 
02:30:00:00, and you wanted to start 10 
minutes into the ADAT tape. In this exam-
ple, you would specify an ADAT Offset of 
negative (-) 02:20:00:00 (2 hours, 30 min-
utes minus 10 minutes).

NOTE: If the incoming time code is later 
than the corresponding location on the 
ADAT tape, a negative offset must be 
specified.

If, on the other hand, the time code source 
started at 00:01:00:00 and you wanted to 
begin at 5 minutes in to your ADAT tape, 
you would specify an ADAT Offset of posi-
tive (+) 00:04:00:00.
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MMC Setup for ADATs

To control one or more ADATs via MMC 
with your Studio 64 XTC:

a Turn off your Studio 64 XTC and any 
ADATs you wish to slave.

b Connect the Studio 64 XTC’s ADAT 
Sync port to the “Sync In” of your 
ADAT.

c If you have additional ADATs, connect 
the Sync Out of the first ADAT to the 
Sync In of the second ADAT—and so 
forth.

d Turn on the Studio 64 XTC and 
ADATs.

e From the front panel of the 
Studio 64 XTC, use the PROGRAM 
button to call up the Sample Rate 
function.

Check the status of the LED for the 
ADAT on the Studio 64 XTC’s front 
panel. 

If lit, the Studio 64 XTC is connected 
successfully to the first ADAT. If not lit, 
turn everything off and check 
connections.

f Using either the Program Editor (PC) 
or OMS Setup (Mac), configure and 
save a Studio 64 XTC user program 
with the following settings.

Sync Reference (Source): Internal
Sample Rate: 48k (default for ADAT)
MTC Source: Computer
Digital Phase Lock: On
ADAT Online: On
ADAT ID: 0

In addition, see ADAT ID and Offset 
(pg. 64) for details on setting an appro-
priate ADAT Offset.

Also, make sure the user program has 
the ADAT routed to and from your com-
puter in the Connection Grid; and 
choose the desired SMPTE Frame Rate 
in the SMPTE Window.

g From either your PC or Macintosh, 
save and store the user program in 
your Studio 64 XTC.

h If using an OMS application, add a 
device to your current Studio Setup 
and assign its port number to 5.

In addition, make sure the device is set 
to send and receive both MTC and 
MMC. And make sure the OMS Device 
ID (in this example, “0”) matches that 
contained in the current Studio 64 XTC 
user program.

Figure 12.4: OMS Device Info for Alesis ADAT

Add a device
assigned to 
port 5.
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If using multiple ADATs, additional units 
should appear in OMS as daisy-chained 
devices on port 5. See Figure 12.5.

Figure 12.5: Multiple ADATs in Studio Setup

In addition, each successive ADAT in 
OMS must be set to an ID one greater 
than the previous. If, for instance, the ID 
of the ADAT connected directly to the 
Studio 64 XTC is defined as “0,” the 
second ADAT should be specified as “1.”

NOTE: The current Studio 64 XTC user 
program sets the ID for the ADAT con-
nected directly to the Studio 64 XTC. 
See ADAT ID and Offset (pg. 64).

i Lastly, set up your sequencing 
software for MMC control of the ADAT 
with the Studio 64 XTC as the sync 
source.

If using an OMS-compatible application, 
simply select the ADAT (the device in 
your Studio Setup connected to port 5) 
as your MMC device.

If using Windows, make sure your 
application directs MMC commands to 
the 64XTC ADAT Out Port.

In some MMC applications you may 
have to specify the type of MMC device 
you are using, its ID, SMPTE offset, and 
how many tracks it has. Consult your 
software’s user manual for details.

Taking the ADAT Offline

The ADAT Online option lets you specify 
whether the Studio 64 XTC communi-
cates with a connected ADAT. If you take 
the ADAT “offline,” time code and trans-
port commands are not sent to the ADAT 
Sync port. And, since the Studio 64 XTC 
doesn’t have to wait for the ADAT to 
locate before it begins generating sync, 
this speeds up the time it takes to lock up 
with your sequencing software.

Using either the Program Editor under 
Windows (see Chapter 8, page 33) or the 
OMS Setup application on the Mac (see 
Chapter 9, page 39), you can specify for 
each user program whether the ADAT is 
online or not.

You can also temporarily take the ADAT 
offline from the front panel of the 
Studio 64 XTC:

a Turn on the Studio 64 XTC and ADAT.

b Using the PROGRAM button, call up 
the Sample Rate sync function. 

The LED for the selected sample rate is 
lit, along with the ADAT LED (indicating 
it's detected and online).

c Press the SYNC button repeatedly 
until the ADAT LED is selected (it 
should blink rapidly). 

After a few seconds, the sample rate 
LED will again become lit, and the ADAT 
LED will then blink slowly (indicating it's 
offline).

Repeat the previous step to place the 
ADAT back online.

Second ADAT daisy-
chained to first ADAT
on port 5
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CONTROLLING OTHER MMC 
DEVICES

The Studio 64 XTC can also control a vari-
ety of MMC devices via its MIDI ports. 
Following is a configuration example for 
the Tascam DA-88.

Using a Tascam DA-88

For the Studio 64 XTC to control the 
Tascam DA-88 via MMC, you will need 
the SY-88 sync card option from Tascam. 
Once installed, the SY-88 provides I/O for 
MTC, MMC, and Word Clock.

Figure 12.6: Controlling Tascam DA-88 via MMC

To control the Tascam DA-88 via MMC 
with your Studio 64 XTC:

a Turn off the Studio 64 XTC and 
Tascam DA-88.

b Install the SY-88 sync card as 
specified by your Tascam 
documentation.

Set dip switch #2 (located on the left side 
of the SY-88 expansion card) to the UP 
position. Set dip switch #6 to the DOWN 
position. Consult your Tascam 
documentation for details.

c Connect the MIDI output of the SY-88 
card to the Studio 64 XTC’s MIDI IN 
port number 1. Connect the MIDI input 
of the SY-88 sync card to the 
Studio 64 XTC’s MIDI OUT port 
number 1.

d Connect the Word Clock Out of the 
Studio 64 XTC to the Word Clock 
input of the Tascam SY-88 sync card.

If there are no other digital recording 
devices involved in this setup (such as 
hard disk recorders), there is no need to 
make this connection.

e Turn on the Studio 64 XTC and DA-88.

f Verify that the DA-88’s Device ID is set 
to 1 (the value used in this example). 
In addition, make sure the DA-88 is in 
Timecode controlled mode, and 
that “timecode out” is set to 
Absolute.

To switch the DA-88 to timecode con-
trolled mode, hold either the down or up 
arrow key and press the other when the 
display is in its ABS time mode (ABS 
LED lit). Again, consult your Tascam 
documentation for details.

Studio 64 XTC

Tascam DA-88 with 
SY-88 Sync Card

MIDI outMIDI in

MIDI out MIDI in
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g Using either the Program Editor (PC) 
or OMS Setup (Mac), configure and 
save a Studio 64 XTC user program 
with the following settings.

Sync Reference (Source): MTC
Sample Rate: 48k (default for DA-88)
MTC Source: Port 1
Digital Phase Lock: On

Also, choose the desired SMPTE Frame 
Rate in the SMPTE Window.

NOTE: If no other audio devices are 
involved in this scenario, you can disable 
Digital Phase Lock for faster lock-up 
times.

h If using an OMS application to control 
the DA-88, configure OMS 
accordingly.

Add a device to your current Studio 
Setup with the DA-88 connected port 1 
of the Studio 64 XTC.

Figure 12.7: OMS Device Info for DA-88

The device defined as the DA-88 in OMS 
should be set to an ID of “0,” which is 
one less than the actual unit (unfortu-
nately, the ID numbering scheme on the 
DA-88 is off by one).

Also, make sure to set the device to 
receive and send both MTC and MMC.

i Lastly, set up your sequencing 
software for MMC control of the DA-88 
with the Studio 64 XTC as the sync 
source.

If using an OMS-compatible application, 
simply select the DA-88 as your MMC 
device.

If using Windows, make sure your 
application directs MMC commands to 
the 64XTC MIDI Out Port that corre-
sponds to the DA-88/SY-88.

In some MMC applications you may 
have to specify the type of MMC device 
you are using, it’s ID, SMPTE offset, and 
how many tracks it has. Consult your 
software’s user manual for details.
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CHAPTER 13: Word/Super Clock, Blackburst 
and Video Sync

This chapter explores some of the real 
world examples of synchronizing various 
audio hardware. Although every possible 
scenario is not covered, hopefully the fol-
lowing examples will provide enough 
information for most users.

USING WORD CLOCK AND 
SUPER CLOCK

Following are some examples using Word 
Clock and Super Clock with digital audio 
hardware.

Analog Multitrack and Pro Tools

Figure 13.1: Syncing analog multitrack and 
Pro Tools

Address source: Analog Multitrack
Time Base source: Analog Multitrack
Super Clock destination: Pro Tools
Sync Ref mode for XTC: SMPTE

This scenario involves syncing to SMPTE 
from an analog multitrack while sending 
Super Clock to Digidesign’s Pro Tools 
hardware. Any fluctuations in the speed of 
the time code entering the Studio 64 XTC 
are compensated for in the generated 
Super Clock—thereby adjusting the 
sample rate playback of the Pro Tool’s 
hardware.

a Turn off your Studio 64 XTC, 
multitrack recorder, and Digidesign 
audio interface.

b Connect the audio out of the 
multitrack’s SMPTE track to the 
SMPTE IN jack of the Studio 64 XTC.

c Connect the Studio 64 XTC’s Super 
Clock port to the “Slave Clock In” of 
your Digidesign audio interface.

d Turn on your equipment.

e Using either the Program Editor on 
the PC, or OMS Setup on the 
Macintosh, edit and store a 

Studio 64 XTC

Digidesign I/O

Analog Multitrack

Slave Clock in

SMPTE Track out

SMPTE in Super Clock out
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Studio 64 XTC user program with the 
Sync Reference mode set to SMPTE. 

Also, make sure to specify the desired 
SMPTE format and sample rate for the 
user program. And, Digital Phase lock 
must be enabled.

f Configure your digital recording 
software to sync to MTC with the 
Studio 64 XTC as the sync source.

In addition, configure any necessary set-
tings for SMPTE frame rate and sample 
rate for the audio hardware.

Consult the appropriate manufacturer’s 
manuals as needed.

Session 8 PC and DA-88

Figure 13.2: Syncing Tascam DA-88 and 
Session 8 PC

Address source: DA-88
Time Base source: DA-88
Word Clock destination: DA-88
Super Clock destination: Session 8
Sync Ref mode for XTC: MTC

This example illustrates controlling the 
Tascam DA-88 (with SY-88 sync card) via 
MMC. In addition, Word Clock is sent to 
the DA-88 and Super Clock to Digide-
sign’s Session 8 PC, which allows the 
digital audio playback of both devices to 
be in sync.

In this example, MTC from the DA-88 is 
the source for both address and time 
base.

a Turn off your Studio 64 XTC, DA-88, 
and Digidesign audio interface.

b Connect the Super Clock Out of the 
Studio 64 XTC to the “Slave Clock In” 
of the Digidesign audio interface.

c Connect the Word Clock Out of the 
Studio 64 XTC to the Word Clock 
input of the Tascam SY-88 sync card.

d Connect the MIDI output of the SY-88 
card to one of the Studio 64 XTC’s 
MIDI inputs. Connect the MIDI input of 
the SY-88 sync card to the MIDI output 
of the Studio 64 XTC.

Make sure to use the same 
Studio 64 XTC port number for each 
MIDI connection.

e Turn on your equipment.

f Make sure the DA-88, Studio 64 XTC, 
and necessary software are 
configured appropriately for MMC 
control.

For details, see Using a Tascam DA-88 
(pg. 67).

g Using either the Program Editor on 
the PC, or OMS Setup on the 
Macintosh, edit and store a 
Studio 64 XTC user program with the 
Sync Reference mode set to MTC. 

Studio 64 XTC

Tascam DA-88 with

MIDI in/out

Digidesign I/O

Super Clock out

Slave Clock in

Word Clock out

Word Clock in

SY-88 Sync Card
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Also, make sure to specify the desired 
SMPTE format and sample rate for the 
user program. And, Digital Phase Lock 
must be enabled.

h Configure your digital recording 
software to control the DA-88 via 
MMC with the Studio 64 XTC as the 
sync source.

In addition, configure any necessary set-
tings for SMPTE frame rate and sample 
rate for the audio hardware.

Consult the appropriate manufacturer’s 
manuals as needed.

USING BLACKBURST/VIDEO 
SYNC

Following are some examples syncing 
digital audio hardware to Blackburst and 
composite video signals.

Video Deck and Pro Tools

Figure 13.3: Syncing Pro Tools to a video deck

Address source: Video Deck
Time Base source: Video Deck
Super Clock destination: Pro Tools
Sync Ref mode for XTC: SMPTE/Video

This scenario involves syncing Digidesign 
Pro Tools hardware to a video deck. The 
video deck, in this example, acts as both 
the address and time base source. The 
Studio 64 XTC generates Super Clock 
(sent to the Pro Tools hardware) based on 
the composite video signal and SMPTE 
from the video deck—thereby ensuring 
the video frames are in sync with the digi-
tal audio playback.

a Turn off your Studio 64 XTC, 
Digidesign audio interface, and video 
deck.

b Connect the video out jack of the 
video deck to the Studio 64 XTC’s 
Blackburst/Video In jack.

c Connect the audio out of the video 
deck (containing the SMPTE time 
code signal) to the SMPTE IN of the 
Studio 64 XTC.

d Connect the Studio 64 XTC’s Super 
Clock Out to the “Slave Clock In” of 
your Digidesign audio interface.

e Turn on your equipment.

f Using either the Program Editor on 
the PC, or OMS Setup on the 
Macintosh, edit and store a 
Studio 64 XTC user program with the 
Sync Reference mode set to SMPTE/
Video. 

Also, make sure to specify the desired 
SMPTE format and sample rate for the 
user program. And, Digital Phase Lock 
must be enabled.

Studio 64 XTC

Digidesign I/O

Video Deck

SMPTE 

SMPTE in

Super Clock out

Track out

Slave Clock in

Video out

Video in
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g Configure your digital recording 
software to sync to MTC with the 
Studio 64 XTC as the sync source.

In addition, configure any necessary set-
tings for SMPTE frame rate and sample 
rate for the audio hardware.

Consult the appropriate manufacturer’s 
manuals as needed.

Blackburst, Video Deck, and 
DA-88

Figure 13.4: Syncing Tascam DA-88 to Blackburst 
generator and video deck

Address source: Video Deck
Time Base source: Blackburst
Word Clock destination: Pro Tools
Sync Ref mode for XTC: SMPTE/Video

This example involves syncing a Tascam 
DA-88 (with SY-88 sync card) to a Black-
burst generator. The Blackburst box 
provides the time base to the 
Studio 64 XTC while also controlling the 

playback speed of the professional video 
deck (SMPTE source). As a result, the 
Studio 64 XTC generates Word Clock and 
SMPTE that keep the DA-88 in sync with 
the video.

NOTE: This example assumes your profes-
sional video deck supports receiving a 
Blackburst (house sync) signal.

a Turn off your Studio 64 XTC, Tascam 
DA-88, video deck, and Blackburst 
generator.

b Connect the audio out of the video 
deck (containing the SMPTE time 
code signal) to the SMPTE IN of the 
Studio 64 XTC.

c Connect the output of the Blackburst 
generator to the Studio 64 XTC’s 
Blackburst/Video In jack.

In addition, connect the Blackburst gen-
erator to the video deck and configure as 
specified by the manufacturer.

d Connect the Word Clock Out of the 
Studio 64 XTC to the Word Clock 
input of the Tascam SY-88 sync card.

e Connect the SMPTE OUT of the 
Studio 64 XTC to the SMPTE input of 
the SY-88 sync card.

Configure the DA-88/SY-88 to chase 
SMPTE time code. Consult your Tascam 
documentation for details.

NOTE: This example does not provide 
for MMC control of the DA-88.

f Turn on your equipment.

Studio 64 XTC

Tascam DA-88 with

Word Clock out

SMPTE in Blackburst in

SY-88 Sync Card

SMPTE out

Video Deck
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g Using either the Program Editor on 
the PC, or OMS Setup on the 
Macintosh, edit and store a 
Studio 64 XTC user program with the 
Sync Reference mode set to SMPTE/
Video. 

Also, make sure to specify the desired 
SMPTE format and sample rate for the 
user program. And, Digital Phase Lock 
must be enabled.

h Configure your digital recording 
software to sync to MTC with the 
Studio 64 XTC as the sync source.

In addition, configure any necessary set-
tings for SMPTE frame rate and sample 
rate for the audio hardware.

Consult the appropriate manufacturer’s 
manuals as needed.

Blackburst, Video Deck, 
Pro Tools, and ADAT

Figure 13.5: Syncing ADAT and Pro Tools to 
Blackburst generator and video deck

Address source: Video Deck
Time Base source: Blackburst
Super Clock destination: Pro Tools
Sync Ref mode for XTC: SMPTE/Video

This scenario syncs Digidesign Pro Tools 
and the Alesis ADAT to a Blackburst sig-
nal. Again, as in the previous example, the 
Blackburst box provides the time base to 
the Studio 64 XTC while controlling the 
playback speed of the video deck.

The Studio 64 XTC generates Super 
Clock (sent to the Pro Tools hardware) 
that keeps its digital audio playback in 
sync with the video and ADAT.

NOTE: This example assumes your profes-
sional video deck supports receiving a 
Blackburst (house sync) signal.

a Turn off your Studio 64 XTC, Alesis 
ADAT, Digidesign audio interface, 
video deck, and Blackburst generator.

b Connect the audio out of the video 
deck (containing the SMPTE time 
code signal) to the SMPTE IN of the 
Studio 64 XTC.

c Connect the output of the Blackburst 
generator to the Studio 64 XTC’s 
Blackburst/Video In jack.

In addition, connect the Blackburst gen-
erator to the video deck and configure as 
specified by the manufacturer.

d Connect the Studio 64 XTC’s Super 
Clock Out to the “Slave Clock In” of 
your Digidesign audio interface.

Studio 64 XTCSMPTE in Blackburst in

Digidesign I/O

Super Clock out

Slave Clock in

Alesis ADAT

ADAT Sync

Sync In

Video Deck
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e Connect the Studio 64 XTC’s ADAT 
Sync port to the “Sync In” of your 
ADAT.

If you have additional ADATs, connect 
the Sync Out of the first ADAT to the 
Sync In of the second ADAT—and so 
forth.

For details on configuring the 
Studio 64 XTC for use with an ADAT, 
see Working with Alesis ADATs (pg. 63).

NOTE: This example does not provide 
MMC control of the ADAT.

f Turn on your equipment.

g Using either the Program Editor on 
the PC, or OMS Setup on the 
Macintosh, edit and store a 
Studio 64 XTC user program with the 
Sync Reference mode set to SMPTE/
Video. 

Also, make sure to specify the desired 
SMPTE format and sample rate for the 
user program. And, Digital Phase Lock 
must be enabled.

NOTE: Since the ADAT will chase 
SMPTE from the Studio 64 XTC in this 
scenario, enter an ADAT offset for the 
user program, if necessary. See 
ADAT ID and Offset (pg. 64) for details.

h Configure your digital recording 
software to sync to MTC with the 
Studio 64 XTC specified as the sync 
source.

In addition, configure any necessary set-
tings for SMPTE frame rate and sample 
rate for the audio hardware.

Consult the appropriate manufacturer’s 
manuals as needed.
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APPENDIX A: Troubleshooting

WHERE TO START

Setting up a MIDI system involves a vari-
ety of components, each of which must be 
working properly before you can success-
fully get down to making music. When 
encountering problems, you should focus 
on each system component separately; 
then focus on the relationships between 
the various components.

Verifying Connections

If you are having trouble with using the 
Studio 64 XTC as a MIDI interface, you 
should first test the unit’s connection to 
your computer. 

If using a PC, see Verifying PC Connec-
tions with XTCDIAG (pg. 26); for 
Macintosh, see Verifying Mac Connections 
with Test Studio (pg. 26).

General Operational Problems

While it is possible you may have a defec-
tive Studio 64 XTC, it is rather unlikely. 
Most difficulties encountered are opera-
tional problems and likely related to 
connections, power usage, software setup, 
or user program settings. 

If you have checked the items just men-
tioned and have verified your computer 
connection, see the following sections on 
MIDI Input/Output Problems (pg. 77) and 
Sync Problems (pg. 80).

MIDI INPUT/OUTPUT 
PROBLEMS

Following are some common MIDI input 
and output problems:

When using the Studio 64 XTC as a 
stand-alone patchbay, no MIDI is routed. 
• Monitor the Studio 64 XTC’s MIDI 

input/output LEDs to see if data is 
routed as expected.

• The Studio 64 XTC user programs 
may not contain the desired routings. 
Use the Program Editor on the PC, or 
OMS Setup on the Mac to make the 
necessary changes. 

• Check MIDI connections. Make sure 
your instrument’s MIDI OUTs are 
connected to the Studio 64’s MIDI 
INs, and vice-versa.

• Check that your instruments are set 
to receive MIDI on the desired 
channels.

• Try using the ALL preset program, 
which routes all inputs to all outputs.



PART 4: Appendices

78 Opcode Systems, Inc.

No MIDI data is received/recorded.
• Verify the Studio 64 XTC is powered 

on and securely connected to your 
computer; Windows users, make sure 
the driver is installed; Mac users, 
make sure OMS is configured 
correctly.

• Check if a red MIDI input LED is 
blinking, indicating data received.

• Verify your instrument’s MIDI OUT 
is connected to the appropriate 
Studio 64 XTC MIDI IN.

• Is your MIDI software set to receive 
MIDI from the correct port number 
(instrument)?

• Is your instrument configured to send 
MIDI?

Certain types of MIDI data or specific 
channels are not recorded/received.
• Some MIDI sequencers have record 

filters. Make sure your sequencer is 
set to receive (record) the desired 
MIDI messages.

• Check that the current Studio 64 XTC 
user program is not filtering the 
desired MIDI messages or channels.

Notes are doubled (or distorted) when 
playing from a keyboard into software.
• If your software’s MIDI thru (or 

echo) is enabled, make sure your key-
board’s “local mode” is disabled.

• MIDI sequencing software generally 
takes care of MIDI routing. There-
fore, you should use a Studio 64 XTC 
user program that contains no rout-
ings (such as the default factory user 
program 1).

No MIDI output. 
• Verify the Studio 64 XTC is powered 

on and securely connected to your 
computer; Windows users, make sure 
the driver is installed; Mac users, 
make sure OMS is configured 
correctly.

• Are the tracks in your MIDI software 
assigned to the correct port number 
(instrument) and channel?

• Is your instrument configured to 
receive MIDI and is it set to the cor-
rect channel(s)?

• Check if the correct green MIDI 
output LED is blinking, indicating 
data sent.

• Verify your instrument’s MIDI IN is 
connected to the appropriate 
Studio 64 XTC MIDI OUT.

Certain types of MIDI data or specific 
channels are not output.
• Check that the current Studio 64 XTC 

user program is not filtering the 
desired MIDI messages or channels.

• Make sure your instrument is set to 
receive the desired MIDI messages 
and is set to receive on the appropri-
ate channel(s).

Sysex is not successfully sent to an 
instrument.
• Make sure there are no MIDI data 

loops present. Try using a 
Studio 64 XTC user program with no 
routings present (like the default fac-
tory user program 1).
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• Make sure the instrument is set to 
receive sysex; some instruments 
require Memory Protect to be OFF.

• Make sure the current Studio 64 XTC 
user program is not filtering sysex.

• Some instruments have a MIDI port 
that acts as both MIDI OUT and 
THRU—make sure it is configured as 
an OUT.

• Some Editor/Librarian programs 
need handshaking communication 
and thus require both MIDI ports 
(OUT and IN) of an instrument to be 
connected. And if both ports of a 
MIDI instrument are connected, 
always use the same Studio 64 XTC 
port number.

• If using an Editor/Librarian program, 
verify the instrument’s device ID 
matches the software settings.

MIDI instrument displays “MIDI Data 
Error” or “MIDI Buffer Full.”
• Check for bad MIDI cables.
• Make sure there no MIDI data loops 

present. Try using a Studio 64 XTC 
user program that contains no rout-
ings (like the default factory user 
program 1).

• If problems persist with user pro-
grams, try restoring the 
Studio 64 XTC to its default state, see 
Initializing User Programs (pg. 32).

Tracks play back with wrong 
instruments, channels, or patches.
• Monitor green MIDI output LEDs to 

see if tracks are sent to the desired 
OUT.

• Make sure tracks are assigned to the 
correct port number (instrument).

• Your instruments’ MIDI receive chan-
nel(s) may not agree with the MIDI 
data sent. Check channel settings in 
your software as well as the channel 
bump settings for the current 
Studio 64 XTC user program.

Some MIDI input/output LEDs glow 
steadily and won’t quit.
• Try selecting the PANIC preset pro-

gram to clear all sounding notes.
• You may have a MIDI loop. Discon-

nect and then reconnect MIDI cables 
for the affected port(s) to break the 
loop. Then, make sure that MIDI data 
output from the Studio 64 XTC cannot 
make its way back into the 
Studio 64 XTC.

• If problems persist with user pro-
grams, try restoring the 
Studio 64 XTC to its default state, see 
Initializing User Programs (pg. 32).
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SYNC PROBLEMS

Below are some common sync and 
SMPTE problems:

ADAT does not respond to sequencing 
software.
• Call up the Studio 64 XTC’s Sample 

Rate function mode from the front 
panel. If the ADAT status LED is lit, 
your connection is correct.

• Verify that the Studio XTC’s current 
user program is configured correctly 
for controlling the ADAT; also check 
that software is set up appropriately. 
See Working with Alesis ADATs 
(pg. 63) for more details.

The Studio 64 XTC SMPTE LED 
indicates no SMPTE signal, or an erratic 
signal. 
• Check that SMPTE connections are 

secure.
• Make sure the sync track is not pro-

cessed by equalization, compression/
limiting, or noise reduction. Avoid 
routing SMPTE signals through a 
mixer.

• Make you are receiving an optimal 
SMPTE signal, which should be in 
the range of -10 db to -3 db.

The Studio 64 XTC responds to SMPTE 
time code but sequencer doesn’t. 
• Verify the software’s sync source is 

assigned to the Studio 64 XTC.
• Make sure the sequencer is set to use 

the correct SMPTE format and offset 
time.

• Verify the sequencer is set to sync to 
SMPTE and is in play or record 
mode.

• See if time code is received in the 
SMPTE Window, which would indi-
cate correct configuration of 
Windows driver on the PC, and OMS 
on the Mac.

Sequencer keeps running even after 
stopping tape.

This is normal when using SMPTE free-
wheel. The Studio 64 XTC cannot detect 
the difference between a stopped tape and 
bad sync data. To reduce this effect, 
adjust the freewheel setting in the 
SMPTE Window.

A tone emanates from SMPTE OUT jack 
when not striping.

This is normal. The Studio 64 XTC’s 
SMPTE OUT jack outputs a constant 
leader tone to facilitate setting record 
levels.

The SMPTE Window displays 30-frame 
Non-Drop when reading 29.97 Non-Drop. 

MIDI Time Code does not differentiate 
between these two SMPTE formats. It is 
therefore important to set your sequenc-
ing software to the frame rate that 
matches the tape’s sync track.
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SMPTE sync problems with 29.97 Drop 
Frame, but not other formats. 
• Verify that the tape indeed has 29.97 

Drop-Frame time code, and that your 
software is set for this format. 

• Make sure your sequencer supports 
this particular SMPTE format.

Erratic timing or jumbled notes when 
playing from the start of sequence. 

The sequencer’s offset time should be at 
least three seconds after the SMPTE start 
time. This is to ensure adequate time for 
tape speed to stabilize and therefore pro-
vide accurate sync lock-up with your 
sequencer.
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APPENDIX B: Networking

The Studio 64 XTC’s Network port con-
nects to an Opcode Studio 4, thereby 
allowing both interfaces to share the same 
computer port. As of the printing of this 
manual, networking is only supported on 
the Macintosh.

NOTE: You cannot use the Network port to 
connect two Studio 64 XTCs.

NOTE: In addition to the Studio 4, future 
Opcode interfaces may also be compatible 
with the Studio 64 XTC’s Network port.

NETWORKING A STUDIO 4 
(MAC)

When networking an Opcode Studio 4 to 
the Studio 64 XTC, there are a few impor-
tant things to keep in mind. Once 
networked, the Studio 4 is primarily used 
as additional MIDI input and output ports 
for the Studio 64 XTC. In fact, MIDI 
devices connected to the Studio 4 appear 
in OMS as Studio 64 XTC devices on 
ports 9-16 (see Figure B.2 on page 80).

In addition, once the Studio 4 is net-
worked some of its advanced capabilities 
are no longer available. For instance, the 
Studio 4 menu is no longer available in 
OMS Setup and therefore “MIDI Routing, 

Channelizing, and Muting” options are 
not accessible. However, it is still possible 
to create OMS Studio Patches containing 
MIDI routings (and processing) between 
devices connected to either interface.

Figure B.1: Studio 64 XTC and Studio 4 networked 
to Macintosh

To network an Opcode Studio 4 to the 
Studio 64 XTC:

a Turn off the Studio 64 XTC, Studio 4, 
and Macintosh.

b Connect the Studio 64 XTC’s Mac port 
to the Mac’s modem or printer port.
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c Connect the Studio 64 XTC’s Network 
port to the Studio 4’s B Port.

Make sure to connect to the Studio 4’s 
computer B port (the one with the little 
picture of the Mac Plus) and not the Thru 
port.

d Configure the Studio 4’s front panel 
switches.

Set the 1mHz/Fast switch to Fast, the 
1-8/9-16 switch to 9-16, and the 
MIDI/B-Thru switch to MIDI.

e Turn on your equipment.

f Launch OMS Setup and choose 
File>New Studio Setup.

When prompted, specify the Mac port 
(modem or printer) to which the 
Studio 64 XTC is connected. Then click 
Search for OMS to search for con-
nected interfaces.

g In the resulting dialog, OMS displays 
the detected Studio 64 XTC. Next click 
OK to search for connected MIDI 
instruments.

Devices successfully detected by OMS 
appear in the following dialog. If a device 
was not detected or if nothing is con-
nected to a particular port, a keyboard 
icon with a red question mark is 
displayed.

Make sure to enable (check) each unde-
fined port you wish to use. Ports 1-4 
correspond to Studio 64 XTC devices, 
port 5 is the ADAT port, and ports 9-16 
correspond to Studio 4 devices.

Figure B.2: Studio Setup containing networked 
Studio 64 XTC and Studio 4

IMPORTANT: MIDI devices connected 
to the Studio 4 actually appear in OMS 
as Studio 64 XTC devices on ports 9-16.

Ports 1-5 are
Studio 64 XTC
devices.

Ports 9-16
are Studio 4
devices.
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APPENDIX C: Windows Drivers

WINDOWS DRIVER 
INSTALLATION

To use the Studio 64 XTC with Windows 
applications, the supplied driver must be 
installed. The easiest way to install the 
driver for the Studio 64 XTC is to run the 
Setup program, located on the PC floppy 
disk included with your package. Addi-
tionally, the driver can be installed from 
within Windows 95 or Windows 3.1.

NOTE: The easiest way to install the driver 
for the Studio 64 XTC is by running the 
Setup program on your PC disk.

IMPORTANT: Before attempting to install 
the Studio 64 XTC driver (from either the 
Setup program, or from the Windows con-
trol panel), make sure the unit is connected 
to your PC and powered on.

Driver Installation under 
Windows 95

a From the Windows 95 taskbar, choose 
Start>Settings>Control Panel.

b Double-click the Add New Hardware 
control panel, and in the following 
dialog click Next.

In the resulting dialog, click Next.

c When windows offers to search for 
hardware, click No and then Next. 

Windows asks what type of hardware 
you are installing.
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d Select Sound, Video and Game 
Controllers as the hardware you’d 
like to install and click Next. 

e When prompted with the list of 
hardware drivers provided by 
Windows 95, click Have Disk.

f As prompted, insert the 
Studio 64 XTC PC disk and specify 
the letter of your floppy drive (usually 
either A:\ or B:\). Click OK. 

Windows accesses the disk and after a 
brief delay, a list of drivers on the disk 
appears.

g Select the Studio64XTC entry and 
click OK.

h In the following dialog, click Finish to 
proceed with driver installation.

After the necessary driver files are 
copied from your floppy disk, the driver 
setup dialog opens.

Figure C.1: Studio 64 XTC setup dialog

i In the driver setup dialog, enter the 
COM port and IRQ for your 
Studio 64 XTC connection. Click OK. 

Generally, COM1 and COM3 default to 
IRQ4, while COM2 and COM4 default to 
IRQ3.

j Exit and restart Windows for the 
driver changes to take effect.

Driver Installation under 
Windows 3.1

a Launch Windows and open the 
Control Panel, located in the Main 
program group.

b Double-click the Drivers option. 

c When the list of installed drivers 
appears, click the Add button. 

A dialog appears presenting a list of driv-
ers included with Windows. 

d Select Unlisted or Updated Driver 
and click OK.

e As prompted, insert the 
Studio 64 XTC PC disk and specify 
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the letter of your floppy drive (usually 
either A:\ or B:\). Click OK. 

Windows accesses the disk and after a 
brief delay, a list of drivers on the disk 
appears.

f Select the Studio64XTC entry and 
click OK.

After the necessary driver files are 
copied from your floppy disk, the driver 
setup dialog opens.

Figure C.2: Studio 64 XTC setup dialog

g In the driver setup dialog, enter the 
COM port and IRQ for your 
Studio 64 XTC connection. Click OK. 

Generally, COM1 and COM3 default to 
IRQ4, while COM2 and COM4 default to 
IRQ3.

h Exit and restart Windows for the 
driver changes to take effect.

CHANGING DRIVER SETTINGS

If necessary, COM port and IRQ settings 
may be changed in the driver setup 
dialog.

Changing Driver Settings under 
Windows 95

To change driver settings under 
Windows 95:

a From the Windows 95 taskbar, choose 
Start>Settings>Control Panel.

b Double-click the Multimedia option. 

The Multimedia Properties dialog opens.

c Click the Advanced tab and then 
double-click MIDI Devices and 
Instruments.

A list of installed MIDI drivers appears.

d Select any entry for the Studio 64 XTC 
and click the Properties button.

The Driver Properties dialog opens.

e Click the Settings button to open the 
driver setup dialog for the 
Studio 64 XTC.

f In the driver setup dialog, enter the 
COM port and IRQ for your 
Studio 64 XTC connection. Click OK. 

g Exit and restart Windows for driver 
changes to take effect.
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Changing Driver Settings under 
Windows 3.1

To change driver settings under 
Windows 3.1:

a Launch Windows and open the 
Control Panel, located in the Main 
program group.

b Double-click the Drivers option.

A list of installed drivers appears.

c Select the entry for the Studio 64 XTC 
and then click the Setup button.

The Driver Setup dialog opens.

d In the driver setup dialog, enter the 
COM port and IRQ for your 
Studio 64 XTC connection. Click OK. 

e Exit and restart Windows for driver 
changes to take effect.

REMOVING THE WINDOWS 
DRIVER

If for some reason you need to remove the 
driver for the Studio 64 XTC, follow the 
steps outlined below.

IMPORTANT: Before executing these edits 
you should make a backup copy of your 
“System.ini” file, located in your Win-
dows\System directory.

Removing the Driver under 
Windows 95

First, remove driver in Control Panel:

a From the Windows 95 taskbar, choose 
Start>Settings>Control Panel.

b Double-click the Multimedia option.

The Multimedia Properties dialog opens.

c Click the Advanced tab and then 
double-click MIDI Devices and 
Instruments.

A list of installed MIDI drivers appears.

d Select any entry for the Studio 64 XTC 
and click the Properties button.

The Driver Properties dialog opens.

e Click the Remove button; then in the 
following warning prompt, click Yes.

f In the Device Removed dialog box, 
again click the OK button. 

Windows prompts you that changes may 
not take effect until restarting.

g Click OK.

h Exit and restart Windows for 
changes to take effect.
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Next, delete the driver files, Stu64xtc.drv 
and Stu64xtc.386:

a From the Windows desktop, navigate 
to the Windows/System folder.

b Locate the files “Stu64xtc.drv” and 
“Stu64xtc.386.” 

c Drag both files to the Recycle Bin.

d Empty the Recycle Bin.

Lastly, edit your System.ini file:

a From the Windows desktop, navigate 
to the Windows folder.

b Locate the file “System.ini” and 
double-click it.

c Once Notepad is launched and 
displaying the System.ini file, locate 
and delete the following lines:

device=stu64xtc.386
midiX=stu64xtc.drv (if present)

X = number specific to your system.

d To save changes to the System.ini 
file, choose File>Save.

e Choose File>Exit to close Notepad 
program.

f Restart Windows for all changes to 
take effect.

Removing the Driver under 
Windows 3.1

First, remove driver in Control Panel:

a Open the Control Panel, located in 
the Main program group.

b Double-click the Drivers option.

A list of installed drivers appears.

c Select the Studio 64 XTC driver and 
click the Remove button. 

d In the following warning dialog click 
Yes.

e When prompted to restart Windows, 
click the Restart Now button.

Next, use the File Manager program to 
delete Stu64xtc.drv and Stu64xtc.386:

a After restarting Windows open 
File Manager, located in the Main 
program group.

b Navigate to the Windows\System 
directory and locate the files 
“Stu64xtc.drv” and “Stu64xtc.386.” 

c Control-click to select both files and 
choose File>Delete. 

d When asked to confirm your delete, 
verify you are deleting the correct 
files and click OK.

e Choose File>Quit to close the 
File Manager program.

Lastly, edit your System.ini file:

a Open the Notepad program, located 
in the Accessories program group.

b Choose File>Open.
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c In the Open dialog box, navigate to 
the Windows\System directory, 
select the “System.ini” file and click 
Open.

d In your System.ini file, locate and 
delete the following lines:

device=stu64xtc.386
midiX=stu64xtc.drv (if present)

(X = number specific to your system)

e To save changes to the System.ini 
file, choose File>Save.

f Choose File>Exit to close the 
Notepad program.

g Restart Windows for all changes to 
take effect.
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APPENDIX D: PC Serial Ports

SETTING UP YOUR SERIAL 
PORT INTERFACE

When connecting the Studio 64 XTC to 
your PC, you must specify which COM 
port it’s connected to, and which IRQ it 
will use. Failing to do either of these cor-
rectly, will result in an error message 
when launching the Program Editor on 
the PC.

The following steps will assist you in iden-
tifying other serial devices on your PC 
and which COM ports they occupy:

a Before hooking up the interface it is 
important to make sure the serial port 
that you are going to use is not being 
used by any other peripheral devices 
in your system (i.e. modems, serial 
mouse, joysticks, hand held 
scanners, etc.)

b If your mouse has a rectangular or 
D-shaped plug, it is a serial mouse 
which may conflict with the interface, 
in which case you should proceed to 
step 3.

If your mouse has a round plug then it is 
a PS2 mouse and should not conflict 
with the interface, in which case you 
should proceed to step 4.

c Look at the ports on the back of the 
computer and locate which one the 
mouse is hooked up to. Using the 
documentation for your computer 
determine the number (COM 1, 
COM 2, etc.) of the port to which the 
mouse is attached. Write this number 
down.

If you are unable to determine the 
number of the COM port to which the 
mouse is attached you may be able to 
get this information by going to the Start 
Button > Settings > Control Panel > 
System > Device Manager > Mouse. 
Look on all pages of this driver informa-
tion for any indication of the COM port, 
Address or IRQ which the mouse driver 
is configured to use. Write this informa-
tion down.

NOTE: If you are still having trouble 
determining which COM port your mouse 
is using, contact the manufacturer of 
your computer and they should be able 
to help you determine which COM port 
your mouse is using.

d Do you have a modem? If yes, 
proceed to step 5. If not, proceed to 
step 6.
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e You need to determine the number of 
the COM port which is being used by 
your modem. To do this go to the 
Start Button > Settings > Control 
Panels > System > Device Manager > 
Modem. Look on all pages for any 
information about the Port, Address 
or IRQ which the modem driver is 
configured to use. Write this 
information down.

NOTE: If you are having trouble finding 
this information contact the manufacturer 
of your modem or computer. They 
should be able to help you determine 
which COM port your modem is attached 
to.

f You should now have a written list of 
the COM ports which are in use by 
your mouse and modem.

If you have no other serial port periph-
eral devices attached to your computer 
then you are ready to proceed to step 7.

If you have other serial port devices then 
you need to determine which COM ports 
those devices are attached to and write 
that information down and then proceed 
to step 7.

g If your list shows no COM ports are in 
use, proceed to step 9. If your list has 
one COM port in use, proceed to 
step 8.

If your list contains two or more items 
then you are going to need to make 
some adjustments before you will be 
able to install the Interface. This is due to 
the fact that COM 1 and COM 3 share 
IRQ 4 and COM 2 and COM 4 share 
IRQ 3. While each individual COM port 
has a distinct Address which can be 
used by the Interface, the Interface will 
not share an IRQ with another device. 

You will need to either remove one of the 
devices (and its corresponding drivers) 
that is currently hooked up to one of the 
serial ports or purchase an after market 
Serial Port Card which is configurable for 
an IRQ and address that are not being 
used by any other devices in your sys-
tem. Once installed this card will give 
you an extra serial port to which you can 
attach any serial port device. Proceed to 
step 8.

h Based on your list of COM ports in 
use you will now select a COM port to 
use for your interface. Choose a COM 
port and IRQ that are not already in 
use by another device.

NOTE: Generally, COM 1 and COM 3 
share IRQ 4 and COM 2 and COM 4 
share IRQ 3. If you are using an after 
market serial port card make sure that 
the IRQ and Address for which the card 
is configured are not used by any other 
devices in your system. The 
Studio 64 XTC driver currently supports 
only COM ports 1 through 4.

i With the computer turned off, remove 
any software keys, dongles, or 
switchboxes from the COM port which 
you are going to connect to the 
Interface.

j Attach the interface to the computer 
using the cable that came with the 
interface and if needed the 9-Pin to 
25-Pin adaptor. Plug in the power 
adaptor for the interface.

k Turn on the interface and computer in 
that order.

l Run the installer from the driver disk 
that came with the interface, by 
double clicking on the setup icon 
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which appears on the disk in 
Windows Explorer.

m When prompted enter the address 
and IRQ of the COM port to which the 
interface is attached.

n Reboot your computer with the 
interface on when the installer 
finishes installing the driver.

o You are now ready to start using the 
patchbay software included with the 
Interface or your sequencing 
software.
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APPENDIX E: OMS Studio Patches for 
Macintosh

WHAT ARE STUDIO PATCHES

Studio Patches route (and process) MIDI 
data to and from instruments contained in 
your current OMS Studio Setup docu-
ment. Studio Patches, which are created 
and edited with the Studio Patches Editor 
application, are stored in Patch docu-
ments on your hard drive.

Each Patch document may contain:

• Up to 128 patches
• Any number of Virtual Controllers
• Any number of Virtual Instruments
• Any number of Program Change 

Sources
• A Patch Chain

Patches can perform a wide range of 
MIDI processing and are constructed by 
connecting various modules together in 
the Studio Patches Editor. The patch 
modules include splitters (for channels, 
note range, and velocities), modifiers (for 
velocity, mono/poly aftertouch, and con-
troller values), a transposer, and a control 
number mapper.

Virtual Controllers and Virtual Instru-
ments are extremely powerful features of 
Studio Patches. A Virtual Controller is the 
output of a MIDI device plus some form of 
MIDI processing. A Virtual Instrument is 
some form of MIDI processing routed to 
one or more MIDI devices. Virtual Con-
trollers and Virtual Instruments can be 
valuable aids for both sequencing and live 
performance. 

Program Change Sources allow you to 
specify various ways to change Studio 
Patches.

A Patch Chain is a sequence of patches 
that can be stepped through with a MIDI 
controller, or the Studio 5’s optional 
footswitches.

Patches are strictly real-time, live-playing 
MIDI connections; they do not actually 
affect the MIDI data that an application 
sends or receives. MIDI applications will 
always receive from the sources to which 
they are connected and be able to send to 
any destinations, regardless of what the 
current patch does.

Since most sequencers provide MIDI thru-
ing from within the application, you may 
wish to keep Studio Patch #1 as an “empty” 
or “do nothing” patch for use with 
sequencer programs.
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Compatible MIDI Interfaces

To use Studio Patches you must have an 
Opcode Studio 5, Studio 4, Studio 64X or 
Studio 64 XTC. Below are some important 
details, specific to each interface, that you 
should know.

• Studio 5: The Studio 5 has built-in 
RAM that can store a Studio Patch 
document. This means that the 
Studio 5 can use Studio Patches 
(recalled from its front panel) without 
being connected to a computer.

• Studio 4: In order to use Studio 
Patches, this interface must be con-
nected to your Macintosh and an 
OMS application must be launched. 
Studio Patch processing occurs in 
addition to any processing performed 
by the Studio 4’s Routing, Channeliz-
ing and Muting window. When first 
learning to use Studio Patches, you 
may want to disable all routings in 
this window.

• Studio 64X, Studio 64 XTC: In 
order to use Studio Patches, this 
interface must be connected to your 
Macintosh and an OMS application 
must be launched.
Studio Patch processing occurs in 
addition to any processing performed 
by the Studio 64’s User/Preset Pro-
grams, as defined in the Program 
Edit Window. When first learning to 
use Studio Patches, you may want to 
disable all routings in this window.

NOTE: Although Studio Patches require 
one of the above mentioned interfaces, you 
can use devices that aren’t attached to your 
interface (such as a SampleCell card) in 
Patch documents.

For a complete and thorough explanation 
on creating and using OMS Studio 
Patches, consult the PDF version of the 
Studio Patches Manual included with 
your Studio 64 XTC package.



Studio 64 XTC Manual 97

INDEX

A

ADAT Sync port 10
Address 49
Alesis ADAT

controlling via MMC 65
ID setting in user program 64
offset in user program 64
using with Studio 64 XTC 63
working with multiple units 66

B

Blackburst/Video In jack 11
Blackburst/Video sync examples 71

C

Configuration
for IBM PC 13
for Macintosh 17
OMS 18

Connections
for IBM PC 13
for Macintosh 17
MIDI instruments 21
serial port considerations (Mac) 18
serial port considerations (PC) 14
SMPTE 56
to two computers 11
verifying with Test Studio (Mac) 26
verifying with XTCDIAG (PC) 26

D

Digital Phase Lock 53

E

Editing User Programs
on the Mac 39
under Windows 33

Expansion port 10

F

Freewheel 49
and Studio 64 XTC 56

Front Panel Descriptions 7
Front Panel Operations 31

initializing user programs 32
monitoring/editing sync settings 32
selecting a program 31
striping SMPTE 32

G

Generating SMPTE 61

H

How to Use this Manual 4

I

Initializing User Programs 32

J

Jam Sync 56

L

Lock-up Time 52

M

Mac port 10
Macintosh

configuration 17
connections 17
MIDI software 19
OMS installation and configuration 18
serial port considerations 18
striping SMPTE from OMS Setup 59
Studio 64 XTC as a second interface 19
syncing to tape 60
using non-OMS applications 19
using OMS-compatible applications 19

MIDI Input jacks 11
MIDI Input LEDs 7



Index

98 Opcode Systems, Inc.

MIDI Instruments
audio connections 23
connecting both MIDI ports 22
connections 21
MIDI routing, merging and processing 23
receiving MIDI from 21
sending MIDI to 22

MIDI Output jacks 11
MIDI Output LEDs 7
MIDI Software

non-OMS applications 19
OMS-compatible applications 19
on Macintosh 19
under Windows 15

MMC 63
control of ADAT 65
control of DA-88 67

MTC 49
sending 61
syncing to 61

N

Network port 10

O

OMS
about 18
installation and configuration 18
Studio Patches 18, 95
using non-OMS applications 19
using OMS-compatible applications 19

OMS Setup (Mac) 39
opening Program Edit Window 39
Program Edit Window 40
program sets 39
SMPTE Window 42
Studio 64XTC menu 42

OMS Studio Patches 18, 95

P

PC
configuration 13
connections 13
serial port considerations 14
Setup Program 14
striping SMPTE with Program Editor 58
syncing to tape 59
Windows MIDI software 15

PC port 10
Power jack 9
Power On LED 9
Power switch 9
Preset Programs 31

ALL 31
PANIC 31
SMPTE 31
TUNE 31

Program button 7
Program Edit Window

Mac 40
PC 34

Program Editor (PC) 33
launching 33
menu reference 36
Program Edit Window 34
Program Sets 33
SMPTE Window 36

Pull Up/Down 52

R

Rear Panel Descriptions 9
ROM version, for Studio 64 XTC

checking from OMS Setup (Mac) 43
checking from Program Editor (PC) 38

S

Sample Rate 51
Serial Port Considerations

for Macintosh 18
for PC 14



Index

Studio 64 XTC Manual 99

SMPTE
about 47
connections 56
formats 48
freewheel 49
generating 61
levels 56
MIDI Time Code 49
offset 48
start time 48
sync track 48
synchronization 48
time code 48

SMPTE In jack 10
SMPTE Out jack 9
SMPTE Window

Mac 42
PC 36

Striping SMPTE
from OMS Setup (Mac) 59
from Program Editor (PC) 58

Studio 64 XTC
about the 3
front panel descriptions 7
front panel operations 31
rear panel descriptions 9
ROM version, checking from 

OMS Setup (Mac) 43
ROM version, checking from 

Program Editor (PC) 38
system requirements 3
test run 25
what’s included 4

Studio 64XTC Menu (Mac) 42
Super Clock 51

sync examples 69
Super Clock Out jack 11
Sync button 7
Sync Function LEDs 7
Sync Reference Modes 50
Sync Status LEDs 8
Synchronization Basics 47

Syncing
to MTC 61
to tape (Mac) 60
to tape (PC) 59

System Requirements 3

T

Tascam DA-88
controlling via MMC 67

Test Run 25
Time Base 49
Troubleshooting

MIDI input/output 77
sync problems 80
where to start 77

U

User Programs
about capabilities 29
default factory 30
editing on the Mac 39
editing under Windows 33
initializing 32

W

Windows Driver
changing settings under Windows 3.1 88
changing settings under Windows 95 87
installation under Windows 3.1 86
installation under Windows 95 85
removing under Windows 3.1 89
removing under Windows 95 88

Word Clock 51
sync examples 69

Word Clock Out jack 10


	Studio�64�XTC Reference Manual
	Opcode Systems, Inc.
	3950 Fabian Way, Suite 100
	Palo Alto, CA 94303
	http://www.opcode.com
	Second Edition
	Opcode Part Number: 110-0300-01
	Copyright ©1998 Opcode Systems, Inc. All rights re...
	Table Of Contents
	PART 1: Overview and Installation 1
	PART 2: Studio�64�XTC Programs 27
	PART 3: Synchronization 45
	PART 4: Appendices 75




	PART 1: Overview and Installation
	CHAPTER 1: Introduction
	About the Studio�64�XTC
	System Requirements
	What’s Included
	Your Opcode Studio�64�XTC package includes:

	How to Use this Manual
	This manual does not attempt to teach fully the fu...
	OMS and Studio Patches Manuals (Mac)


	Customer Support and Registration
	Registering your Studio�64�XTC
	Contacting Opcode


	CHAPTER 2: Panel Descriptions
	Front Panel
	Figure 2.1: Studio�64�XTC Front Panel

	Program Button
	MIDI Input LEDs
	MIDI Output LEDs
	Sync Function LEDs
	Sync Button
	Sync Status LEDs
	Sample Rate Function
	Sync Ref Function
	SMPTE Function

	On LED
	Power On/Off Switch
	Rear Panel
	Figure 2.2: Studio�64�XTC Rear Panel
	Following is a description of the rear panel conne...

	9V DC 300MA
	SMPTE Out
	SMPTE In
	The Studio�64�XTC receives SMPTE via this 1/4” unb...

	Word Clock Out
	Expansion
	ADAT Sync
	Network
	Mac
	PC
	This 9-pin serial port connects to your IBM PC 165...

	Super Clock Out
	Blackburst/Video In
	MIDI Outputs
	MIDI Inputs
	Dual Computer Connection

	CHAPTER 3: IBM PC Configuration
	IBM PC Configuration
	Connect Hardware
	a Turn off your computer, peripherals, a and MIDI ...
	b Plug one end of the provided serial b cable into...
	c Using standard MIDI cables, connect c the MIDI O...
	d Plug the small end of the provided d power adapt...
	e Turn on your computer, peripherals, e Studio�64�...
	Serial Port Considerations (PC)

	Run the Setup Program
	To install the necessary PC software for the Studi...
	a Insert the PC disk and double-click a the Setup ...
	b When prompted, specify which b Studio�64�XTC sof...
	c Specify an install directory and then c click Ne...
	d When prompted, specify which COM d port and IRQ ...
	e Once you’ve specified the COM port e settings, c...
	f When prompted, restart Windows for f changes to ...


	Using Windows Software
	When recording performance data, make sure you ena...

	OMS Applications under Windows
	Figure 3.1: OMS Studio Setup containing a Figure 3...


	CHAPTER 4: Macintosh Configuration
	Macintosh Configuration
	Connect Hardware
	a Turn off your computer, peripherals, a and MIDI ...
	b Plug one end of the provided serial b cable into...
	c Using standard MIDI cables, connect c the MIDI O...
	d Plug the small end of the provided d power adapt...
	e Turn on your computer, peripherals, e Studio�64�...
	Serial Port Considerations (Mac)

	Install and Configure OMS
	a Insert the provided OMS disk 1 and a double-clic...
	b When reaching the main install b screen, choose ...
	c Insert each disk as prompted.
	d When completed, exit the installer and d restart...
	e After restarting, launch the e OMS�Setup applica...
	About OMS
	OMS Studio Patches

	Studio�64�XTC as a Second Interface
	Using Macintosh MIDI Software
	OMS-Compatible Applications
	Non-OMS Applications

	CHAPTER 5: MIDI Instrument Connections
	MIDI Instrument Connections
	Receiving MIDI from your Instruments
	Figure 5.1: Instruments sending MIDI data

	Sending MIDI to your Instruments
	Figure 5.2: Instruments receiving MIDI data
	When to Connect both Ports
	Sharing Ports
	Figure 5.3: Two instruments sharing the same port ...
	Figure 5.4: Two instruments sharing the same port ...


	MIDI Routing, Merging and Processing
	Audio Connections

	CHAPTER 6: A Test Run
	Verifying MIDI Connections
	a Turn on the Studio�64�XTC along with a any conne...
	b Press the PROGRAM button b repeatedly until the ...
	c Play some notes on a MIDI controller c connected...
	d Using the PROGRAM button, select d the TUNE prog...
	e Press the PROGRAM button once to e end the TUNE ...
	f Press the PROGRAM button f repeatedly to select ...
	g Press the PROGRAM button once to g exit from SMP...
	h Next select the PANIC program.

	Verifying PC Connections with XTCDIAG
	a Exit Windows and restart your a computer in DOS ...
	b At the DOS prompt, type:
	c Then press the ENTER key.
	d When prompted, specify your COM d port and IRQ s...
	e Once your connection is verified as e valid, use...

	Verifying Mac Connections with Test Studio
	PART 2: Studio�64�XTC Programs

	CHAPTER 7: Studio�64�XTC Programs
	User Programs
	Each Studio�64�XTC user program can control the fo...

	Default Factory User Programs
	Figure 7.1: Routing for User Program 1
	Figure 7.2: Routing for User Program 2
	Figure 7.3: Routing for User Program 3
	Figure 7.4: Routing for User Program 4

	Default Sync Settings
	In addition to the routings contained in each defa...

	Preset Programs
	Front Panel Operations
	A variety of Studio�64�XTC operations can be acces...

	Selecting a Program
	Striping from the Front Panel
	Monitoring/Editing Sync Settings

	Initializing User Programs
	The user programs for the Studio�64�XTC are set to...
	a Turn off the Studio�64�XTC.
	b Press the PROGRAM button and hold b it down whil...
	c After several seconds, release the c PROGRAM but...



	CHAPTER 8: Editing User Programs under CHAPTER 8: ...
	Using the Program Editor
	a Locate the 64xtc.exe program icon in a the direc...
	Figure 8.1: Program Edit Window for PC


	Program Sets
	Storing Changes

	Program Edit Window (PC)
	Figure 8.2: Program Edit Window for PC
	A Connection Grid: Defines connecA tions, which ro...
	B Message Filters: Specifies which B MIDI messages...
	C Channel Filters: Specifies which C channels are ...
	D Channel Bump: Shifts the channel D assignment fo...
	E Sync Reference: Determines the E Sync Reference ...
	F Sample Rate: Determines the F sample rate, and w...
	G MTC Source: When the Sync ReferG ence mode is sp...
	H Digital Phase Lock: When checked, H this option ...
	I ADAT Online: Determines whether I the Studio�64�...
	J Adat Offset: Specifies an offset for J SMPTE tra...
	K ADAT ID: Sets the ID for the ADAT K connected di...
	L SMPTE Button: Opens the SMPTE L Window.
	M SMPTE Monitor: Displays scrolling M SMPTE frames...
	N Program Name Field: Lets you type N in a new nam...
	O Preset/User Programs Button: O Specifies whether...
	P Program Buttons: Specifies which P program is cu...
	Q Status Field: Displays communicaQ tion status be...

	SMPTE Window
	To open the SMPTE Window, click the SMPTE button i...
	Figure 8.3: SMPTE Window for PC
	A SMPTE Monitor: Displays scrolling A SMPTE frames...
	B SMPTE Start: Specifies the SMPTE B start time wh...
	C Freewheel: Allows SMPTE synchroC nization to con...
	D Format: Specifies the frame rate to D be used wh...
	E Send MTC To: Directs MIDI Time E Code (based on ...
	F Stripe/Stop: Starts striping with the F current ...
	G OK: Closes the SMPTE Window with G the current s...


	Program Editor Menu Reference
	File>New
	File>Open
	File>Save
	Saves the current program set with its current fil...
	File>Save As
	File>Exit
	Edit>Copy Program
	Edit>Paste Program
	Settings>Name Program Set
	Settings>Always On Top
	Settings>Store Current Program
	Settings>Retrieve Current Program
	Settings>Store All Programs
	Settings>Retrieve All Programs
	Help>Quick Help
	Help>About Studio�64XTC Program Editor



	CHAPTER 9: Editing User Programs on the CHAPTER 9:...
	Using OMS Setup
	a Launch OMS Setup by double- a clicking its progr...
	b From within OMS Setup, choose b Studio�64XTC>Edi...
	Figure 9.1: Program Edit Window for Mac


	Program Sets
	Storing Changes

	Program Edit Window (Mac)
	Figure 9.2: Program Edit Window for Macintosh
	A Connection Grid: Defines connecA tions, which ro...
	B Message Filters: Specifies which B MIDI messages...
	C Channel Filters: Specifies which C channels are ...
	D Channel Bump: Shifts the channel D assignment fo...
	E Rename button: Lets you rename E the current use...
	F Program pop-up: Specifies which F program is bei...
	G Digital Phase Lock: When checked, G this option ...
	H Sample Rate: Determines the H sample rate, and w...
	I Sync Source: Determines the Sync I Reference mod...
	J MTC Source: When the Sync ReferJ ence mode is sp...
	K Adat Offset: Specifies an offset for K SMPTE tra...

	SMPTE Window
	To open the SMPTE Window, choose Studio�64XTC>SMPT...
	Figure 9.3: SMPTE Window for Mac

	Following is an explanation for each of the compon...
	A SMPTE Monitor: Displays scrolling A SMPTE frames...
	B Freewheel: Allows SMPTE synchroB nization to con...
	C Start Time: Specifies the SMPTE C start time whe...
	D Format: Specifies the frame rate to D be used fo...
	E Start Striping Button: Starts stripE ing with th...
	F Stop Striping Button: Stops SMPTE F striping; to...


	Studio�64XTC Menu
	Studio�64XTC>Edit Programs
	Studio�64XTC>SMPTE
	Studio�64XTC>Open
	Studio�64XTC>Save
	Studio�64XTC>Save As
	Studio�64XTC>Copy Program
	Studio�64XTC>Paste Program
	Studio�64XTC>Load Current Program
	Studio�64XTC>Store Current Program
	Studio�64XTC>Load All Programs
	Studio�64XTC>Store All Programs
	Studio�64XTC>Display ROM Version

	PART 3: Synchronization

	CHAPTER 10: Synchronization Basics
	About SMPTE
	SMPTE is a timing reference signal developed by th...
	Synchronization
	SMPTE Time Code
	Figure 10.1: SMPTE time code frames

	SMPTE Sync Track
	Figure 10.2: SMPTE sync track

	SMPTE Formats
	SMPTE Start Time
	SMPTE Offset
	MIDI Time Code (MTC)
	Freewheel


	Time Base and Address
	Blackburst and Video Signals
	Blackburst and composite video signals allow video...

	Sync Reference Modes
	The Studio�64�XTC’s Sync Reference setting specifi...
	Table 1: Studio�64�XTC Sync Reference Modes


	Internal
	Internal/Video
	SMPTE
	SMPTE/Video
	MTC
	MTC/Video
	Word Clock and Super Clock
	Sample Rate
	Pull Up/Down Setting
	When to Use Pull Up
	When to Use Pull Down

	Lock-up Time
	Digital Phase Lock
	There are, however, a few differences in the way t...


	CHAPTER 11: Working with SMPTE and MTC
	Studio�64�XTC and SMPTE
	How the Studio�64�XTC Stripes SMPTE
	How the Studio�64�XTC Reads SMPTE
	Reading 29.97 Non-Drop

	SMPTE Freewheel
	Jam Sync
	SMPTE Connections
	SMPTE OUT Connection
	Figure 11.1: Recording SMPTE to track 8 of Figure ...

	SMPTE IN Connection
	Figure 11.2: Receiving SMPTE from multitrack


	Striping/Syncing to Tape under Windows
	Striping with Program Editor (PC)
	a Make sure your tape deck is a connected to the S...
	b Set record levels to between �10db b and -3db, a...
	c Open the Program Editor by double- c clicking th...
	Figure 11.3: SMPTE Window for PC

	d Choose the desired SMPTE Format d by clicking on...
	e Specify the SMPTE Start Time.
	f Choose any desired MTC f destination(s).
	g Place your tape deck in record mode g and start ...
	h After recording 3-4 seconds of just h the leader...
	i Allow sufficient time for the sync i track to be...

	Syncing to Tape (PC)
	Although details will vary from one program to the...
	a Make sure connections between your a tape deck a...
	b Set tape playback levels to between b �10 db and...
	c Set the Studio�64�XTC’s Sync c Reference mode to...
	d Launch your MIDI sequencing d software. If you a...
	e Set your sequencer’s sync source to e the 64XTC ...
	f Configure your sequencer to sync to f SMPTE (or ...
	g Put your sequencer in play or record g mode.
	h Start the tape rolling at the desired h location...


	Striping/Syncing to Tape on the Macintosh
	Striping with OMS Setup (Mac)
	a Make sure your tape deck is a connected to the S...
	b Set record levels to between -10db b and -3db, a...
	c Launch the OMS Setup program and c choose Studio...
	Figure 11.4: SMPTE Window for Mac

	d Choose the desired SMPTE Format d from the pop-u...
	e Specify the SMPTE Start Time.
	f Place your tape deck in record mode f and start ...
	g After recording 3-4 seconds of just g the leader...
	h Allow sufficient time for the sync h track to be...

	Syncing to Tape (Mac)
	a Make sure connections between your a tape deck a...
	b Set tape playback levels to between b �10 db and...
	c Set the Studio�64�XTC’s Sync c Reference mode to...
	d Launch your MIDI sequencing d software. If using...
	e Set your sequencer’s sync source to e the Studio...
	f Configure your sequencer to sync to f SMPTE (or ...
	g Put your sequencer in play or record g mode.
	h Start the tape rolling at the desired h location...

	Generating SMPTE
	MIDI Time Code
	Generating MTC
	Figure 11.5: SMPTE Window (PC), MTC routed to Figu...
	Figure 11.6: Connection Grid (Mac), MTC routed to ...
	Sending MTC from MIDI Software (with Digital Phase...


	CHAPTER 12: ADATs and other MMC Devices
	About MIDI Machine Control
	Working with Alesis ADATs
	Figure 12.1: Controlling one or more ADATs from th...

	ADAT�ID and Offset
	Figure 12.2: Sync settings from Program Editor (PC...
	Figure 12.3: Sync settings from OMS Setup (Mac)
	ADAT�ID
	ADAT Offset

	MMC Setup for ADATs
	To control one or more ADATs via MMC with your Stu...
	a Turn off your Studio�64�XTC and any a ADATs you ...
	b Connect the Studio�64�XTC’s ADAT b Sync port to ...
	c If you have additional ADATs, connect c the Sync...
	d Turn on the Studio�64�XTC and d ADATs.
	e From the front panel of the e Studio�64�XTC, use...
	f Using either the Program Editor (PC) f or OMS Se...
	g From either your PC or Macintosh, g save and sto...
	h If using an OMS application, add a h device to y...
	Figure 12.4: OMS Device Info for Alesis ADAT
	Figure 12.5: Multiple ADATs in Studio Setup

	i Lastly, set up your sequencing i software for MM...


	Taking the ADAT Offline
	a Turn on the Studio 64 XTC and ADAT.
	b Using the PROGRAM button, call up b the Sample R...
	c Press the SYNC button repeatedly c until the ADA...

	Controlling other MMC Devices
	Using a Tascam DA-88
	Figure 12.6: Controlling Tascam DA-88 via MMC
	To control the Tascam DA-88 via MMC with your Stud...
	a Turn off the Studio�64�XTC and a Tascam DA-88.
	b Install the SY-88 sync card as b specified by yo...
	c Connect the MIDI output of the SY-88 c card to t...
	d Connect the Word Clock Out of the d Studio�64�XT...
	e Turn on the Studio�64�XTC and DA-88.
	f Verify that the DA-88’s Device ID is set f to 1 ...
	g Using either the Program Editor (PC) g or OMS Se...
	h If using an OMS application to control h the DA-...
	Figure 12.7: OMS Device Info for DA�88

	i Lastly, set up your sequencing i software for MM...



	CHAPTER 13: Word/Super Clock, Blackburst CHAPTER 1...
	Using Word Clock and Super Clock
	Analog Multitrack and Pro Tools
	Figure 13.1: Syncing analog multitrack and Figure ...
	a Turn off your Studio�64�XTC, a multitrack record...
	b Connect the audio out of the b multitrack’s SMPT...
	c Connect the Studio�64�XTC’s Super c Clock port t...
	d Turn on your equipment.
	e Using either the Program Editor on e the PC, or ...
	f Configure your digital recording f software to s...

	Session 8 PC and DA-88
	Figure 13.2: Syncing Tascam DA-88 and Figure 13.2:...
	a Turn off your Studio�64�XTC, DA-88, a and Digide...
	b Connect the Super Clock Out of the b Studio�64�X...
	c Connect the Word Clock Out of the c Studio�64�XT...
	d Connect the MIDI output of the SY-88 d card to o...
	e Turn on your equipment.
	f Make sure the DA-88, Studio�64�XTC, f and necess...
	g Using either the Program Editor on g the PC, or ...
	h Configure your digital recording h software to c...

	Using Blackburst/Video Sync
	Following are some examples syncing digital audio ...

	Video Deck and Pro�Tools
	Figure 13.3: Syncing Pro Tools to a video deck
	a Turn off your Studio�64�XTC, a Digidesign audio ...
	b Connect the video out jack of the b video deck t...
	c Connect the audio out of the video c deck (conta...
	d Connect the Studio�64�XTC’s Super d Clock Out to...
	e Turn on your equipment.
	f Using either the Program Editor on f the PC, or ...
	g Configure your digital recording g software to s...

	Blackburst, Video Deck, and DA�88
	Figure 13.4: Syncing Tascam DA-88 to Blackburst Fi...
	a Turn off your Studio�64�XTC, Tascam a DA-88, vid...
	b Connect the audio out of the video b deck (conta...
	c Connect the output of the Blackburst c generator...
	d Connect the Word Clock Out of the d Studio�64�XT...
	e Connect the SMPTE OUT of the e Studio�64�XTC to ...
	f Turn on your equipment.
	g Using either the Program Editor on g the PC, or ...
	h Configure your digital recording h software to s...

	Blackburst, Video Deck, Pro�Tools, and ADAT
	Figure 13.5: Syncing ADAT and Pro Tools to Figure ...
	a Turn off your Studio�64�XTC, Alesis a ADAT, Digi...
	b Connect the audio out of the video b deck (conta...
	c Connect the output of the Blackburst c generator...
	d Connect the Studio�64�XTC’s Super d Clock Out to...
	e Connect the Studio�64�XTC’s ADAT e Sync port to ...
	f Turn on your equipment.
	g Using either the Program Editor on g the PC, or ...
	h Configure your digital recording h software to s...

	PART 4: Appendices

	APPENDIX A: Troubleshooting
	Where to Start
	Verifying Connections
	General Operational Problems
	MIDI Input/Output Problems
	When using the Studio�64�XTC as a stand-alone patc...
	No MIDI data is received/recorded.
	Certain types of MIDI data or specific channels ar...
	Notes are doubled (or distorted) when playing from...
	No MIDI output.
	Certain types of MIDI data or specific channels ar...
	Sysex is not successfully sent to an instrument.
	MIDI instrument displays “MIDI Data Error” or “MID...
	Tracks play back with wrong instruments, channels,...
	Some MIDI input/output LEDs glow steadily and won’...

	Sync Problems
	Below are some common sync and SMPTE problems:
	ADAT does not respond to sequencing software.
	The Studio�64�XTC SMPTE LED indicates no SMPTE sig...
	The Studio�64�XTC responds to SMPTE time code but ...
	Sequencer keeps running even after stopping tape.
	A tone emanates from SMPTE OUT jack when not strip...
	The SMPTE Window displays 30-frame Non-Drop when r...
	SMPTE sync problems with 29.97 Drop Frame, but not...
	Erratic timing or jumbled notes when playing from ...



	APPENDIX B: Networking
	Networking a Studio�4 (Mac)
	a Turn off the Studio�64�XTC, Studio�4, a and Maci...
	b Connect the Studio�64�XTC’s Mac port b to the Ma...
	c Connect the Studio�64�XTC’s Network c port to th...
	d Configure the Studio�4’s front panel d switches....
	e Turn on your equipment.
	f Launch OMS Setup and choose f File>New Studio Se...
	g In the resulting dialog, OMS displays g the dete...


	APPENDIX C: Windows Drivers
	Windows Driver Installation
	Driver Installation under Windows�95
	a From the Windows 95 taskbar, choose a Start>Sett...
	b Double-click the Add New Hardware b control pane...
	c When windows offers to search for c hardware, cl...
	d Select Sound, Video and Game d Controllers as th...
	e When prompted with the list of e hardware driver...
	f As prompted, insert the f Studio�64�XTC PC disk ...
	g Select the Studio64XTC entry and g click OK.
	h In the following dialog, click Finish to h proce...
	i In the driver setup dialog, enter the i COM port...
	j Exit and restart Windows for the j driver change...

	Driver Installation under Windows�3.1
	a Launch Windows and open the a Control Panel, loc...
	b Double-click the Drivers option.
	c When the list of installed drivers c appears, cl...
	d Select Unlisted or Updated Driver d and click OK...
	e As prompted, insert the e Studio�64�XTC PC disk ...
	f Select the Studio64XTC entry and f click OK.
	g In the driver setup dialog, enter the g COM port...
	h Exit and restart Windows for the h driver change...

	Changing Driver Settings
	If necessary, COM port and IRQ settings may be cha...

	Changing Driver Settings under Windows 95
	a From the Windows 95 taskbar, choose a Start>Sett...
	b Double-click the Multimedia option.
	c Click the Advanced tab and then c double-click M...
	d Select any entry for the Studio�64�XTC d and cli...
	e Click the Settings button to open the e driver s...
	f In the driver setup dialog, enter the f COM port...
	g Exit and restart Windows for driver g changes to...

	Changing Driver Settings under Windows 3.1
	To change driver settings under Windows�3.1:
	a Launch Windows and open the a Control Panel, loc...
	b Double-click the Drivers option.
	c Select the entry for the Studio�64�XTC c and the...
	d In the driver setup dialog, enter the d COM port...
	e Exit and restart Windows for driver e changes to...


	Removing the WIndows Driver
	If for some reason you need to remove the driver f...

	Removing the Driver under Windows�95
	First, remove driver in Control Panel:
	a From the Windows 95 taskbar, choose a Start>Sett...
	b Double-click the Multimedia option.
	c Click the Advanced tab and then c double-click M...
	d Select any entry for the Studio�64�XTC d and cli...
	e Click the Remove button; then in the e following...
	f In the Device Removed dialog box, f again click ...
	g Click OK.
	h Exit and restart Windows for h changes to take e...

	Next, delete the driver files, Stu64xtc.drv and St...
	a From the Windows desktop, navigate a to the Wind...
	b Locate the files “Stu64xtc.drv” and b “Stu64xtc....
	c Drag both files to the Recycle Bin.
	d Empty the Recycle Bin.

	Lastly, edit your System.ini file:
	a From the Windows desktop, navigate a to the Wind...
	b Locate the file “System.ini” and b double-click ...
	c Once Notepad is launched and c displaying the Sy...
	d To save changes to the System.ini d file, choose...
	e Choose File>Exit to close Notepad e program.
	f Restart Windows for all changes to f take effect...


	Removing the Driver under Windows�3.1
	First, remove driver in Control Panel:
	a Open the Control Panel, located in a the Main pr...
	b Double-click the Drivers option.
	c Select the Studio�64�XTC driver and c click the ...
	d In the following warning dialog click d Yes.
	e When prompted to restart Windows, e click the Re...

	Next, use the File Manager program to delete Stu64...
	a After restarting Windows open a File�Manager, lo...
	b Navigate to the Windows\System b directory and l...
	c Control-click to select both files and c choose ...
	d When asked to confirm your delete, d verify you ...
	e Choose File>Quit to close the e File�Manager pro...

	Lastly, edit your System.ini file:
	a Open the Notepad program, located a in the Acces...
	b Choose File>Open.
	c In the Open dialog box, navigate to c the Window...
	d In your System.ini file, locate and d delete the...
	e To save changes to the System.ini e file, choose...
	f Choose File>Exit to close the f Notepad program....
	g Restart Windows for all changes to g take effect...



	APPENDIX D: PC Serial Ports
	SETTING UP YOUR SERIAL PORT INTERFACE
	a Before hooking up the interface it is a importan...
	b If your mouse has a rectangular or b D�shaped pl...
	c Look at the ports on the back of the c computer ...
	d Do you have a modem? If yes, d proceed to step 5...
	e You need to determine the number of e the COM po...
	f You should now have a written list of f the COM ...
	g If your list shows no COM ports are in g use, pr...
	h Based on your list of COM ports in h use you wil...
	i With the computer turned off, remove i any softw...
	j Attach the interface to the computer j using the...
	k Turn on the interface and computer in k that ord...
	l Run the installer from the driver disk l that ca...
	m When prompted enter the address m and IRQ of the...
	n Reboot your computer with the n interface on whe...
	o You are now ready to start using the o patchbay ...
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